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Warranty, Liability and Support 

Note The Application Examples are not binding and do not claim to be 
complete regarding the configuration, equipping and any eventuality. The 
Application Examples do not represent customer-specific solutions. They 
are only intended to provide support for typical applications. You are 
responsible for ensuring that the described products are used correctly. 
These Application Examples do not relieve you of the responsibility of 
safely and professionally using, installing, operating and servicing 
equipment. When using these Application Examples, you recognize that 
we cannot be made liable for any damage/claims beyond the liability 
clause described. We reserve the right to make changes to these 
Application Examples at any time without prior notice. If there are any 
deviations between the recommendations provided in these Application 
Examples and other Siemens publications – e.g. Catalogs – the contents 
of the other documents have priority. 

 
 

We do not accept any liability for the information contained in this 
document. 

Any claims against us – based on whatever legal reason – resulting from 
the use of the examples, information, programs, engineering and 
performance data etc., described in this Application Example shall be 
excluded. Such an exclusion shall not apply in the case of mandatory 
liability, e.g. under the German Product Liability Act 
(“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of 
life, body or health, guarantee for the quality of a product, fraudulent 
concealment of a deficiency or breach of a condition which goes to the root 
of the contract (“wesentliche Vertragspflichten”). The damages for a breach 
of a substantial contractual obligation are, however, limited to the 
foreseeable damage, typical for the type of contract, except in the event of 
intent or gross negligence or injury to life, body or health. The above 
provisions do not imply a change of the burden of proof to your detriment. 

It is not permissible to transfer or copy these Application Examples or 
excerpts of them without first having prior authorization from Siemens 
Industry Sector in writing. 

If you have any questions concerning this document please e-mail us to the 
following address: 

online-support.automation@siemens.com 

mailto:online-support.automation@siemens.com�
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Preface 

Objective of the application 

This application is designed for users ... 

 who gained initial experiences with WinCC already. 
It conveys knowledge about the interaction of the individual SIMATIC 
configuration tools and shows how their configuration can be made 
easier. 

Main contents of this application 

The following main points are discussed in this application: 

 TIA 

 Prerequisites 

 Creating a Project 

 Tags transfer 

 Alarms 

 System diagnostics 

 Process diagnostics 

 Trends 

 User archives 

 Time synchronization 

 Basic Process Control 

Topics not covered by this application 

This application does not contain a description ... 

 of the engineering tools used (STEP 7, WinCC). 

 of the installation of STEP 7 or any required communication drivers. 

Previous knowledge in these fields is assumed. 

Validity 

The examples were created with WinCC V7.0 and STEP 7 V5.4. 

Industry Automation and Drives Technologies Service & Support Portal 

This entry is taken from the Internet Service Portal of Siemens AG, Industry 
Automation and Drives Technologies. The following link takes you directly 
to the download page of this document. 

http://support.automation.siemens.com/WW/view/en/34995306 

 

http://support.automation.siemens.com/WW/view/en/34995306�
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1 TIA 

1.1 What is TIA? 

TIA stands for "Totally Integrated Automation" and it is an automation 
technology strategy which has been designed and developed by Siemens 
since 1996. 
 
This strategy defines the interaction of extensive single components, tools 
(SW) and the related services (spare parts service etc.). 
 
The consistency of TIA offers the involved companies simplification and 
cost savings for their value chain (OEM, system integrators, planners and 
end customers). The complete product and system range offers solutions 
for the continuous (process / engineering technology) and discrete 
manufacture / automation. 

1.2 Core statement 

Totally Integrated Automation can be described with a reduced formula: 

 TIA is 

– an extensive product / system offer combined with services. 

plus 

– consistency which improves the interaction of the components 
forming a system. 

plus 

– openness and flexibility for any automation job.  

 

This offer facilitates and entails the benefit of meeting the economic 
requirements of any customer better, faster and at an improved quality 
level, i.e. more efficiently. 
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1.3 Details 

Figure 1-1 

 

 The interaction is ensured with a consistency existing across the four 
automation levels: 

–  management level 

–  operator level 

–  control level  

–  field level 

 In particular, the services frequently determine the economic benefit of 
the involved companies (EPC, OEM, plant engineers, control cabinet 
builders, system integrator and final customer) when an automation 
system is to be realized. 
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1.4 Efficiency 

Figure 1-2 

 

 The extensive I°IA/DT product range offers six system properties. The 
customer also specifies general requirements for automation based on 
his economic requirements. These requirements are not only supported 
by the Siemens automation strategy / TIA architecture but added values 
will be achieved based on the TIA system properties which an 
inhomogeneous automation will not offer.  

 On the left side you can see the product range which comprises the 
136,000 products offered by I°IA/DT. In addition to its specific product 
properties every single product contains six consistent system 
properties within one application interacting in reaching a solution. 

 On the right side you will find the customer's driving forces or economic 
requirements which our customers and, in particular, their management 
have to deal with every day. In addition to these requirements our 
customers also have general requirements for their individual 
automation, e.g. "openness, support of international standards" and 
"scalability / modularity" to achieve investment protection or flexibility of 
their automation. 

 Moreover the "horizontal" and "vertical" integration gains increasing and 
more elementary importance. These two requirements have played a 
rather secondary role to the customers so far. 
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1.5 Vertical integration 

Figure 1-3 

 

 

The Siemens products offer consistency across all 4 levels within 
automation and drive solutions which saves on costs and efforts. 

 

 The field level contains the biggest number of components. 
From the simple asynchronous motor via actuators, sensors or process 
instruments, process analyzers to products which permit distributed 
automation designs (I/O modules with ET 200). 

 The control level contains the products which, on the one hand, control 
the automation (controllers) and, on the other hand, permit the operator 
to operate and monitor the automated process via operator panels 
(HMI). 

 The operator level provides the customer with an overview over the 
entire automated system from one point in the case of complex 
automation systems. Control systems (DCS) or a SCADA system 
(WinCC) provide the plant manager with the desired, relevant and 
condensed information in any form. 

 The management level represents the interaction between the 
automation system and the customer's ERP system. The connection 
between the economic data and the automation data (field level) are 
very important for medium-scale and large-scale production lines for 
providing the plant managers with the relevant information for their 
decisions. 
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1.6 Horizontal integration 

Figure 1-4 

 

 

Horizontal integration or consistency means the advantage of acquiring 
information from the entire production process starting with incoming goods 
(discrete) via the main process (process engineering, continuous and/or 
discrete) to goods output (discrete) and reverse. 
 
The horizontal consistency provides transparency of the entire process to 
avoid failures and save costs. 

In addition the customer can reduce the following automation-related 
expenses: 

 expenses for spare parts and costs. 

 same operation of the tools (e.g. engineering SW) in each of the three 
horizontal phases. 

 optimization of the personnel expenses as the number of software and 
hardware used can be reduced to a necessary minimum. 
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1.7 Added value 

Figure 1-5 

 

 

The portfolio for different production requirements is too big for dealing in one 
workshop with all added values which the integration of WinCC provides. 

 Uniform representation of all automation devices and networks in the 
editors and project browsers (SIMATIC Manager, NETPRO Editor, 
topology editor). 

 Start of the configuration and programming tools with a double-click in 
SIMATIC Manager (HMI configuration: WinCC or WinCC flexible). 

 Consistent access to the process data from the management level 
down to the field level. 

 Direct access to STEP7 icons from out of WinCC / WinCC flexible. 

 Central loading of all projects from out of the SIMATIC Manager. 

 Disturbances are consistently displayed with all information from the 
control to the operator level. 

 Automation view (system diagnostics): Diagnosable modules signal 
errors through the reporting of system error, without extensive 
configuration. 

 Process view (process diagnostics): Production monitoring with S7-
PDIAG and ProAgent, chronological reporting from control to HMI. 

 Process data analysis with DowntimeMonitor (DTM), ProcessMonitor 
(PCM), PM-Analyze or PM-Quality. 
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 Remote diagnostics with WebNavigator, DataMonitor, 
AlarmControlCenter (for passing on the alarms). 

 Vertical integration through distributed systems (server-server 
communication, CAS, etc.). 

 Central user administration via SIMATIC Logon. 

 Time synchronization between the levels. 

 Uniform licence management (Automation Licence Manager is the 
central tool for handling SIMATIC WinCC, STEP 7, etc.). 

 Worldwide support and service of the entire plant is provided by one 
company (http://support.automation.siemens.com). 

1.8 Further reading 

This list is not complete and only represents a selection of relevant 
literature. 

Table 1-1 

 Topic Title 

\1\ Further 
Information 

https://www.automation.siemens.com/_de/tia/index.htm 

\2\ Siemens I IA/DT 
Customer 
Support 

http://support.automation.siemens.com 

 

https://www.automation.siemens.com/_de/tia/index.htm�
http://support.automation.siemens.com/�
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2 Prerequisites 

2.1 Hardware requirements 

The following list contains all components used in the example: 

Table 2-1 

Number Module Ordering number 

1 UR1 6ES7 400-1TA00-0AA0 

1 PS 407 4A 6ES7 407-0DA01-0AA0 

1 CPU 414-3 PN/DP 6ES7 414-3EM05-0AB0 

1 IM151-3PNHFV50 6ES7 151-3BA22-0AB0 

1 PM-E DC24V 6ES7 138-4CA01-0AA0 

1 4DI DC24V HF 6ES7 131-4BD01-0AB0 

2 2DO DC24V/0.5A HF 6ES7 132-4BB01-0AB0 

1 2AI I 2/4WIRE HF 6ES7 134-4MB02-0AB0 

1 2AO I HF 6ES7 135-4MB02-0AB0 

1 PC with Ethernet interface --- 

 

Note You can also execute some of the topics dealt with (e.g. ALARM_S) with 
a 300-series CPU. If you want to practice all topics discussed in this 
document (e.g. Alarm_8) you will need a CPU of the 400 series. 

 

2.2 Software requirements 

The following list contains all programs used in the example: 

Table 2-2 

Component Note 

SIMATIC WinCC V7.0 Program is used for visualization of the process. 

SIMATIC STEP 7 V5.4+SP3 Program is used for program generation for control of the 
process. 

SIMATIC NET V7.0 Program contains the communication drivers. 

 

2.3 Installing the software 

This chapter describes the software components to be installed. It is also 
important to read the descriptions, manuals and any delivery information 
supplied with the products. 
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Installation order 

To integrate WinCC in STEP 7 you have to install WinCC and also STEP 7. 
For a new installation the following installation order is recommended:  

1. Installation of STEP 7  

2. User-defined installation of WinCC 

 

Procedure for WinCC 

1. In the start menu of the operating system open "Settings > Control Panel 
> Software". 

2. Select "SIMATIC WinCC V7.0" and click "Change/Delete". The WinCC 
setup program opens. 

3. Select whether single components or options are to be installed. 
Components which have already been installed will be displayed. 

4. Put the WinCC product DVD in the DVD drive when prompted. When the 
start page of the DVD is opened via the autorun function, close the window 
with "Finish". 

5. Follow the on-screen instructions. 
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Table 2-3 

 Action Screenshot 

1. Select the following 
communication 
extensions during the 
installation: 

 
2. Select the following 

options during the 
installation: 

 
 

2.4 Further instructions for installation 

You can install the required WinCC components at the same time when 
you follow the described steps. However, STEP 7 can also be installed at 
any time later. Single WinCC components might have to be post-installed 
then. 
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2.5 Language settings 

This documentation only contains pictures in English. It might be easier for 
you to follow the examples when you select English for your configuration 
tools. 

 In SIMATIC Manager you select the language via "Options > Settings... 
> Language". 

 In WinCC you select the language via "Options > Language...". 

2.6 Further reading 

Bibliographic references 

This list is not complete and only represents a selection of relevant 
literature. 

Table 2-4 

 Topic Title 

/1/ STEP7 V5.4 Documentation 
Basic Knowledge 

6ES7810-4CA08-8AW0 

/2/ Documentation of WinCC V7.0 http://support.automation.siemens.com/
WW/view/en/29489481 

Internet links 

This list is not complete and only represents a selection of relevant 
literature. 

Table 2-5 

 Topic Title 

\1\ Requirements for the 
installation of STEP 7 V 5.4 

http://support.automation.siemens.com/
WW/view/en/24059047 

\2\ Installation of WinCC V7.0 on 
an MUI operating system if the 
language set in Windows is not 
English 

http://support.automation.siemens.com/
WW/view/en/32817147 

\3\ Integrating an existing WinCC 
project into a STEP 7 project 

http://support.automation.siemens.com/
WW/view/en/11841504 

\4\ Siemens I IA/DT Customer 
Support 

http://support.automation.siemens.com 

https://support.automation.siemens.com/WW/llisapi.dll?query=6ES7810-4CA08-8AW0&func=cslib.cssearch&content=skm%2Fmain.asp&lang=de&siteid=csius&objaction=cssearch&searchinprim=&nodeid99=�
http://support.automation.siemens.com/WW/view/en/29489481�
http://support.automation.siemens.com/WW/view/en/29489481�
http://support.automation.siemens.com/WW/view/en/24059047�
http://support.automation.siemens.com/WW/view/en/24059047�
http://support.automation.siemens.com/WW/view/en/32817147�
http://support.automation.siemens.com/WW/view/en/32817147�
http://support.automation.siemens.com/WW/view/en/11841504�
http://support.automation.siemens.com/WW/view/en/11841504�
http://support.automation.siemens.com/�
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3  Creating a Project 

3.1 Introduction 

Here you get an overview over the steps which are required for the creation 
of an integrated WinCC project. 
 

The instruction describes the creation of the PLC station, PC station and 
networking of these components. 
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3.2 STEP 7 configuration 

3.2.1 Inserting the PLC 

Table 3-1 

Step Action 

1.  Start the Simatic Manager and create a new project (File > New). 

2.  Insert a new SIMATIC 400 station (Insert > Insert New Object > SIMATIC 400 
Station). 
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Step Action 

3.  Open HW Config (Edit > Open Object) to configure your modules. 

 
4.  Insert a rack "UR1" with the order number: 6ES7 400-1TA00 from the hardware 

catalog (View > Catalog). 
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Step Action 

5.  Insert a power supply "PS 405 4A" with the order number: 6ES7 405-0DA01-0AA0 
on slot 1 of the rack from the hardware catalog (View > Catalog). 
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Step Action 

6.  Insert a CPU "414-3 PN/DP" V5.0 with the order number: 6ES7 414-3EM05-0AB0 
on slot 2 of the rack from the hardware catalog (View > Catalog). 
Note: 
When you select the CPU in the catalog all slots which can be used in the rack are 
highlighted. 
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Step Action 

7.  The dialog "Properties - Ethernet interface" is opened, the subnet is displayed as 
"not networked". Close the dialog box with “OK”. 
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Step Action 

8.  Save and compile HW Config (Station > Save and compile). 
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3.2.2 Inserting the PC station (WinCC) 

Table 3-2 

Step Action 

1.  Insert a PC station in your project (Insert > Insert New Object > SIMATIC PC 
Station) and open HW Config (Edit > Open Object) to configure it. 
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Step Action 

2.  From the HMI folder of the hardware catalog (View > Catalog) insert a "WinCC 
application" on slot 2 of the rack. 



 
Creating a Project

WinCC – Examples of integrated engineering with STEP 7  Entry ID: 34995306

 

Version V1.0 Issue 27.04.2009 28/230
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 C
o

p
yr

ig
h

t 
20

09
 A

ll 
rig

h
ts

 r
e

se
rv

ed
 

   

Step Action 

3.  From the hardware catalog (View > Catalog) insert a communication processor "SW 
V6.2 SP1" on slot 1 of the rack. 
The inserted communication processor must comply with the one installed in the PC. 
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Step Action 

4.  The dialog "Properties - Ethernet interface" is opened, the subnet is displayed as 
"not networked". Save and compile HW Config (Station > Save and compile). 
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3.3 WinCC types 

Here you will find details on the different variants of the WinCC application. 

 

Figure 3-1 

 
 

Table 3-3 

Name Explanation 

SPOSA Application Connectivity Station. 

WinCC Appl. Client Ref Reference to a so-called Basis Client. 

WinCC Application Master server in a multi-station project. 

WinCC Application (stby) Standby server as redundancy partner in a multi-
station project. 

WinCC Application Client Client in a multi-station project. 

WinCC Application Ref Reference to a so-called Basis-OS. 

WinCC CAS Appl. Central archive server (master server or non-
redundant archive server). 

WinCC CAS Appl. (stby) Central archive server (standby server). 
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3.4 Network configuration 

Table 3-4 

Step Action 

1.  Open the NetPro editor (Options > Configure network) and import an Industrial 
Ethernet subnet from the hardware catalog (View > Catalog). 
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Step Action 

2.  The Industrial Ethernet subnet is created. 

3.  Click on the icon of the interface of a node (green field), keep the left mouse-button 
pressed and drag the mouse pointer to the subnet. 
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Step Action 

4.  Defining the properties: Double-click on the interface node and define the IP address 
in the dialog field "Properties > Parameters". Save the settings and load the 
parameters to all involved network nodes then. 
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3.5 Network connections 

The following table shows the different connection types, their networks 
and the blocks required for communication. 

 

Table 3-5 

Connection type Subnet Connection between... SFB/FB/FC 

S7 connection MPI, 
PROFIBUS, 

Industrial 
Ethernet 

S7 - S7, S7 - PG/PC, 
S7 - PG/PC with WinCC 
With MPI also: M7 - M7, 

M7 - S7, M7 - PG/PC 
S7 - Partners in another project 

(S7, PG/PC with WinCC) 

SFBs USEND, 
URCV, BSEND, 

BRCV, GET, PUT, 
START, STOP, 

RESUME, STATUS, 
USTATUS 

S7 connection, 
fault-tolerant 

PROFIBUS, 
Industrial 
Ethernet 

S7(H) - S7(H), 
S7(H) - PC Station (H) 

SFBs USEND, 
URCV, BSEND, 
BRCV, START, 

STOP, RESUME, 
STATUS, USTATUS 

PTP connection Point-to-point   
(computer log 

RK 
12/3964(R)) 

S7 - S7, S7 - S5, 
S7 - Non-Siemens devices 

S7 - Partners in another project
(S7, non-Siemens devices) 

SFBs BSEND, 
BRCV, GET, PUT, 
STATUS, PRINT 

FMS connection PROFIBUS 
(FMS 

protocol) 

S7 - S7, S7 - S5, S7 - PG/PC, 
S7 - non-Siemens devices, 
S7 – message to all nodes 

S7 - Partners in another project 
(S7, S5, PG/PC, 

non-Siemens devices) 

FBs READ, WRITE, 
IDENTIFY, 

OSTATUS, REPORT 

FDL connection PROFIBUS 
(FDL protocol)

S7 - S7, S7 - S5, S7 - PC/PG, 
S7 - non-Siemens devices 

S7 - Partners in another project 
(S7, S5, PG/PC, 

non-Siemens devices) 

FCs AG_SEND, 
AG_RECV, 

AG_LSEND, 
AG_LRECV 

ISO Transport Industrial 
Ethernet 

(ISO 
Transport) 

S7 - S7, S7 - S5, S7 - PC/PG, 
S7 - non-Siemens devices, 

S7- unspecific 
S7 - Partners in another project 
(S7, S5, PG/PC, non-Siemens 

devices, unspecific) 

FCs AGSEND, AG-
RECEIVE 

AG_LSEND, 
AG_LRECV, 

AG_LOCK,AG_UNL
OCK 
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Connection type Subnet Connection between... SFB/FB/FC 

ISO-on-TCP 
connection 

Industrial 
Ethernet 
(TCP/IP 
protocol) 

S7 - S7, S7 - S5, S7 - PC/PG, 
S7 - non-Siemens devices, 

S7 – unspecific 
S7 - Partners in another project 
(S7, S5, PG/PC, non-Siemens 

devices, unspecific) 

FCs AGSEND, AG-
RECEIVE 

AG_LSEND, 
AG_LRECV, 
AG_LOCK, 

AG_UNLOCK 

TCP connection 
Industrial Ethernet 

Industrial 
Ethernet 
(TCP/IP 
protocol) 

S7 - S7, S7 - S5, 
S7 - PC/PG, 

S7 - non-Siemens devices, 
S7 – unspecific 

S7 - Partners in another project 
(S7, S5, PG/PC, non-Siemens 

devices, unspecific) 

FCs AG_SEND*, 
AG_RECV*, 

AG_LSEND**, 
AG_LRECV** 
AG_LOCK, 

AG_UNLOCK 

UDP connection Industrial 
Ethernet 
(TCP/IP 
protocol 

S7 - S7, S7 - S5, S7 - PG/PC, 
S7 - non-Siemens devices, S7 – 

unspecific 
S7 - Partners in another project 
(S7, S5, PG/PC, non-Siemens 

devices, unspecific) 

FCs AGSEND, AG-
RECEIVE 

AG_LSEND, 
AG_LRECV 

e-mail connection Industrial 
Ethernet 
(TCP/IP 
protocol) 

S7 - unspecific (S7 - mail 
server) 

FCs AG-SEND, 
AG_LSEND 

* The FCs „AG_SEND“ and „AG_RECV“ can only be used with an S7-300 
(depending on the version of the used CPs). 

** The FCs “AG_LSEND” and “AG_LRECV” can both be used with an S7-
400 and with an S7-300 (depending on the version of the used CPs). 

3.6 Compiling 

 The HMI relevant configuration data must be transferred from STEP 7 
to the WinCC database. 

There are different options for starting the "Compile OS" wizard in the 
SIMATIC Manager. 

 If you wish to compile the configuration data of a certain Operator 
Station, select the OS first and start the wizard via the menu option 
"Edit > Compile". Alternatively you can select the menu option 
"Compile" in the context menu of the OS. 

 If you wish to compile the configuration data of several or all Operator 
Stations, start the wizard for "Compile several OS" (Options > Wizard 
"Compile several OS" > Start...). 

In the transfer the process tags are stored in the tag management, user 
texts in the text library and alarms in the alarm logging of the WinCC 
project. 
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3.6.1 What functions are executed during the compilation? 

 Creation of communication driver SIMATIC S7 PROTOCOL SUITE. 

 Creation of WinCC units, e.g. Industrial Ethernet, PROFIBUS, etc. 

 Creation of a logic connection for every S7 program. 

 Creation of raw data variables for the alarm and archiving system. 

 Creation of the structure types for the block types to be transferred to 
WinCC and global data blocks. 

 Creation of process tags in the tag management. 

 Generation of alarms. 

 Transfer of alarms and user texts. 

3.6.2 When should the compilation be carried out? 

 Before the WinCC runtime is started for the first time. 

 After new block instances have been added or block names have been 
changed. 

 After control and unit texts have been changed. 

 After the control and monitoring attributes of an instance have been 
changed. 

 After alarm and user texts have been changed. 

 

Figure 3-2 
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3.7 Configuration tool 

The configuration tool offers a simple and powerful option to configure 
mass data in WinCC. Microsoft Excel is used as the user interface here. It 
allows you to create a WinCC project in Microsoft Excel and take 
advantage of the control options which Microsoft Excel offers. 

The configuration tool allows you to create a new WinCC project and to 
configure it in Excel from the start. Further you can import existing WinCC 
projects and process them further in Excel. 

The configuration is made in a special type of Excel file, a so-called WinCC 
project file. 
It contains different types of spreadsheets which serve for the configuration 
of certain types of WinCC objects. The configuration tool can be used to 
configure the data of the data manager, alarm logging, tag logging and text 
library. 

 

Note In the configuration tool only such connections or variables of channels 
can be processed which are included in the standard scope of WinCC. 

 

Figure 3-3 

 

Installing the configuration tool 

The WinCC configuration tool can be installed in two different ways: 

 During the setup of WinCC select in the dialog "Programs" the entry 
"WinCC V7.0 complete". 

 Install the WinCC Configuration Tool from the WinCC DVD. 

– On the WinCC DVD go to the directory 
"InstData\WinCC\setup\Products\ConfigurationTool". 

– Double-click the "setup.exe" file. 
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3.8 Further reading 

This list is not complete and only represents a selection of relevant 
literature. 

Table 3-6 

 Topic Title 

\1\ WinCC V7.0 
Documentation 
Basic 
Knowledge 

http://support.automation.siemens.com/WW/view/en/29
221062 

\2\ Siemens I IA/DT 
Customer 
Support 

http://support.automation.siemens.com 

http://support.automation.siemens.com/WW/view/en/29221062�
http://support.automation.siemens.com/WW/view/en/29221062�
http://support.automation.siemens.com/�
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4 Tags 

4.1 Introduction 

Tags with value assignment from the process are designated as process 
tags or external tags in WinCC. 

For process tags you determine in the tag management through which 
communication driver WinCC is connected with the automation system and 
in which way the data exchange is carried out. The associated tags are 
created in the directory structure of this communication driver. 

Tags without value assignment from the process, the so-called internal 
tags, are created in the directory "Internal tags". 

 There are two procedures for the tag import: 

– The selection of the tags via the tag selection dialog of WinCC. 

– The automatic tag generation in WinCC via the setting of flags in the 
tag management of STEP 7. 

Note WinCC tags can also be exported / imported with the Smart Tools 
"Variables Import/Export" (VarExim.exe) and "Configuration Tool". These 
tools are shipped with WinCC as standard. 

For more information, please refer to the entry: 

http://support.automation.siemens.com/WW/view/en/22016422 

 

4.2 Selecting STEP 7 symbols 

In the process of WinCC configuration you connect WinCC objects, e.g. I/O 
fields or archive tags, with tags via which the objects are assigned the 
current process values in runtime. 

There are two groups of tags which you can select for the process 
connection: 

 WinCC tags 

– This group comprises the internal and external tags of the tag 
management. 

 STEP 7 symbols 

– These are all inputs, outputs and flags from the symbol list and all 
global data blocks of the assigned S7 programs. 

Direct access to STEP 7 symbols is made via: 

– the tag selection dialog. 

– the tag bar of the Graphics Designer. 

 

http://support.automation.siemens.com/WW/view/en/22016422�
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Note You can also export / import the symbol table of STEP 7 to edit it in 
Excel. 

For more information, please refer to the entry: 

http://support.automation.siemens.com/WW/view/en/22781586 

 

 

The following figure schematically shows the most important components of 
the solution: 

Figure 4-1 

 

http://support.automation.siemens.com/WW/view/en/22781586�
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4.2.1 Principle of operation 

In contrast to the external WinCC tags the STEP 7 symbols can also be 
accessed without previous "Compile OS" and without selection with the 
HMI attribute.  

During the process connection an "implicit compilation" is carried out and 
the symbol is transferred to the tag management of the WinCC project. 

 

Table 4-1 

Step Action 

1.  Creating STEP 7 project. 

2.  Creating WinCC project or integrating existing project. 

3.  Configuring network. 

4.  Creating connection. 

5.  Creating tags. 

 

Overview and description of the user interface 

The following screenshot shows the tag selection dialog. 

Figure 4-2 
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4.2.2 Transfer of tags 

Table 4-2 

Step Action 

1.  Transfer of tags from the symbol table to WinCC 
Select the "symbol table" and then select the tag which you want to import. 
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Step Action 

2.  Transfer of tags from a global data block to WinCC 
Select the data block and then select the tag which you want to import. 

3.  Transfer of several tags 
Select several tags and then push the transfer symbol. 
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Step Action 

4.  Structure of the tag name: 
<STEP 7 program name> + <symbol name of the data block> + <tag name within 
the data block> 
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4.3 Automatic generation 

Tags via which the current process values shall be assigned to the objects 
in runtime get the attribute "S7_m_c" in STEP 7. This HMI attribute is 
evaluated during the OS compilation and the respective tag is automatically 
created in WinCC. 

4.3.1 Principle of operation 

In contrast to the selection of STEP 7 symbols through the tag selection 
dialog, the tags are marked with the HMI attribute in STEP7 here.  

During "Compile OS" the tags are transferred to the tag management of the 
WinCC project then. 

Table 4-3 

Step Action 

1.  Creating STEP 7 project. 

2.  Creating WinCC project or integrating existing project. 

3.  Configuring network. 

4.  Setting attributes (flags) 

5.  Creating connection and tags 
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4.3.2 Attributing individual tags in the symbol editor 

Table 4-4 

Step Action 

1.  Open the symbol editor and select "View > Columns R, O, M, C, CC". 
The respective attributes can be set via the properties dialog "Special Object 
Properties" of a symbol.  

 
2.  Select the attribute "Operator Control and Monitoring" to make the symbol available 

as tag in WinCC. 

 Overview of the special object properties 
– R = Monitoring 
– O  = Operator Control and Monitoring with WinCC 
– M = Alarm properties 
– C  = Communication properties 
– CC = Control at Contact 
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Step Action 

3.  When you create the attribute "Operator Control and Monitoring" you can specify 
additional parameters for the tag using the "More>>" button. 

 
 

4.3.3 Attributing of individual tags in a data block  

Table 4-5 

Step Action 

1.  Open the data block in the block editor. The respective attributes can be set via the 
properties dialog "Object Properties" of a symbol. 
Set the attribute "S7_m_c" and the corresponding value to "true". 
Save and close the data block. 
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Step Action 

2.  If in the respective line at least one attribute has been set, it will be marked with a 
flag. 

 
3.  Invoke the "Special Object Properties" of the attributed data block via the properties 

dialog.  
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Step Action 

4.  Tick "Operator Control and Monitoring" to activate the previously set attributes. 

 
 

 



 
Tags

WinCC – Examples of integrated engineering with STEP 7  Entry ID: 34995306

 

Version V1.0 Issue 27.04.2009 50/230
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 C
o

p
yr

ig
h

t 
20

09
 A

ll 
rig

h
ts

 r
e

se
rv

ed
 

   

4.3.4 Attributing input and output parameters of a function block 

Table 4-6 

Step Action 

1.  Invoke the "Object Properties" of an interface symbol in the function block via the 
properties dialog. 
Note: 
Only IN, OUT and IN_OUT parameters can be assigned an HMI attribute.  
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Step Action 

2.  Set the attribute "S7_m_c" and the corresponding value to "true" there. 
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Step Action 

3.  Invoke the function block with its corresponding instance data block. 

4.  Invoke the "Special Object Properties" of the attributed instance data block via the 
properties dialog and tick "Operator Control and Monitoring" to activate the previously set 
attributes.

 



 
Tags

WinCC – Examples of integrated engineering with STEP 7  Entry ID: 34995306

 

Version V1.0 Issue 27.04.2009 53/230
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 C
o

p
yr

ig
h

t 
20

09
 A

ll 
rig

h
ts

 r
e

se
rv

ed
 

   

4.3.5 Compiling 

To transfer the changes to WinCC a compilation must be started. For 
further information, please refer to the Chapter 3.6. 

 

Note WinCC tags get the status "write-protected" if they have been created by 
AS-OS-Engineering (OS compilation). In that case the tags cannot be 
edited in the WinCC project but only in the corresponding STEP 7 project. 
If, for instance, the attribute "S7_m_c = true" is set at a block connection, 
an entry in the global data block or symbol table, a corresponding tag will 
be created in the WinCC tag management during the compilation. The 
WinCC data type depends on the data type in the STEP 7 project here. 
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4.3.6 S7 data types supported by WinCC  

Table 4-7 

Data type Format adaptation 

Binary tag No 

Signed 8-bit value yes 

Unsigned 8-bit value yes 

Signed 16-bit value yes 

Unsigned 16-bit value yes 

Signed 32-bit value yes 

Unsigned 32-bit value yes 

Floating-point number 32-bit IEEE 754 yes 

Text variable 8-bit character set yes 

Signed 8-bit value no 

Raw data type no 

 

Note Arrays, structures and UDTs (user defined tags) are not supported. 

4.4 Further reading 

Bibliographic references 

This list is not complete and only represents a selection of relevant 
literature. 

Table 4-8 

 Topic Title 

\1\ Siemens I IA/DT 
Customer Support 

http://support.automation.siemens.com 

Internet links 

This list is not complete and only represents a selection of relevant 
literature. 

Table 4-9 

 Topic Title 

\1\ Options of the 
variable export / 
import 

http://support.automation.siemens.com/WW/view/en/
22016422 

\2\ Options of the 
symbol table 
export / import 

http://support.automation.siemens.com/WW/view/en/
22781586 

 

 

http://support.automation.siemens.com/�
http://support.automation.siemens.com/WW/view/en/22016422�
http://support.automation.siemens.com/WW/view/en/22016422�
http://support.automation.siemens.com/WW/view/en/22781586�
http://support.automation.siemens.com/WW/view/en/22781586�
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5 Messages 

5.1 Introduction 

The alarm system is a subsystem of WinCC which serves for monitoring 
the processes. 

At certain states and changes in the process the alarm system generates 
alarms and outputs them in tables in runtime. The alarms help to detect 
critical situations at an early stage and to avoid downtimes. 

 There are two different message procedures: 

– the bit message procedure. 

– the message number procedure. 

5.2 Bit message procedure 

When the bit message procedure is used the alarms are configured in 
WinCC. Tags are assigned to the alarms. During the process the tag values 
are read out from the control at regular intervals. Depending on the states 
of the read out values the configured alarms are displayed in WinCC. 

5.2.1 Principle of operation 

The bit message procedure has the following features: 

 The configuration is made in WinCC. 

 WinCC polls the tags in regular intervals. 

 High bus load 

 The time stamp is assigned by Alarm Logging. 
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5.2.2 Configuring bit messages 

Table 5-1 

Step Action 

1.  Create a new tag of the data type "Unsigned 16-bit value". 

2.  Open in the WinCC Explorer the "Alarm Logging" editor. 

 



 
Messages

WinCC – Examples of integrated engineering with STEP 7  Entry ID: 34995306

 

Version V1.0 Issue 27.04.2009 57/230
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 C
o

p
yr

ig
h

t 
20

09
 A

ll 
rig

h
ts

 r
e

se
rv

ed
 

   

Step Action 

3.  Create a new bit message in the "Alarm Logging" editor. To do this, click on "Append 
New Line" in the context menu of the table window. 

4.  Select the message tag. 
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Step Action 

5.  Set the properties of the bit message. 

6.  Create a message display in the "Graphics Designer". 
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Step Action 

7.  Enable the start of the "Alarm Logging" in the properties dialog of the "Computer" 
settings. 

 
 

5.3 Message number procedure 

 When the message number procedure is used the events to be 
signalled are already assigned message texts during the program 
creation in STEP 7 and assigned to the message numbers. 

 Message numbers and the corresponding message texts are 
transferred to WinCC during generation. 

 Thus, when in the production mode an event occurs which has to be 
signalled, the CPU only transfers the alarm number to WinCC with the 
time stamp. 
In WinCC the alarm number, the time of the event and the 
corresponding message text will be displayed. 

5.3.1 Features 

The message number procedure has the following features: 

 The configuration is made in STEP 7. 

 The control actively sends a message telegram. 

 Low bus load 

 The time stamp is assigned by the control. 

 High effort when changes are made to an existing plant. 
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5.3.2 Message types 

There are three different message types to be considered in the 
configuration: 

 Block-related messages 

 Symbol-related messages 

 User-defined diagnostic messages 

Block-related messages 

They are used in the event of program-synchronous events, e.g. limit value 
monitoring, and they have the following features: 

 Synchronous to cycle of the PLC. 

 WinCC or WinCC flexible (only Alarm_S and Alarm_D) can be used for 
displaying. 

 Supported by S7-300 and S7-400. 

 Is triggered via message blocks: 
ALARM_8, ALARM_8P, NOTIFY, NOTIFY_8P, ALARM_S(Q), 
ALARM_D(Q). 

 Transfer to WinCC through AS-OS compilation. 

Symbol-related messages 

They are used if a program-synchronous display is not required, e.g. for 
displaying a button as a symbol, and they have the following features: 

 Asynchronous to cycle of the PLC. 

 Only WinCC can be used for displaying. 

 Supported only by S7-400. 

 Configured via the symbol table. 

 Downloaded to control via SDBs. 

 Transfer to WinCC through AS-OS compilation. 

User-defined diagnostic messages 

They are used when diagnostic messages of the diagnostic buffer are 
displayed. 

 Synchronous to cycle of the PLC. 

 Display of the diagnostic buffer on the programming device. 

 Supported by S7-300 and S7-400. 

 Triggered via the message block "WR_USMSG". 
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5.3.3 Overview of message blocks 

Table 5-2 

Symbolic block 
name 

System block Acknowledg
eable 

Accompanying 
values 

CPU 

ALARM_SQ SFC17 yes yes, 1 S7-300 / S7-400 

ALARM_S SFC18 no yes, 1 S7-300 / S7-400 

ALARM_DQ SFC107 yes yes, 1 S7-300 / S7-400 

ALARM_D SFC108 no yes, 1 S7-300 / S7-400 

NOTIFY SFB36 no yes, max. 10 only S7-400 

NOTIFY_8P SFB31 no yes, max. 10 only S7-400 

ALARM SFB33 yes yes, max. 10 only S7-400 

ALARM_8 SFB34 yes no only S7-400 

ALARM_8P SFB35 yes yes, max. 10 only S7-400 

 

 

Note ALARM_S(Q) and ALARM_D(Q) are preferably used in the lower 
performance range (WinCC flexible) whereas the other message blocks 
are used in the higher performance range (WinCC). 

In the message creation with ALARM_S(Q) and ALARM_D(Q) the 
operating system uses temporarily storage space in the system memory. 

If you delete, for instance, an FB in the CPU with ALARM_S(Q) and 
ALARM_D(Q) calls it may happen that the corresponding system 
resources will be occupied permanently. 

If you reload the FB with ALARM_S(Q) and ALARM_D(Q) calls, it may 
happen that ALARM_S(Q) and ALARM_D(Q) will not work properly 
anymore. 

ALARM_D(Q) provides the advantage over ALARM_S(Q) that the 
system resources can be released temporarily with the system 
function "DEL_SI". 
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5.3.4 Message classes 

When you configure the message system every message is assigned a 
message class. 

Thus you need not specify numerous basic settings individually for each 
message but you can determine the settings for the whole message class. 

WinCC provides 16 message classes and two preset system message 
classes. 

The following message classes are offered as a standard: 

• Fault. 

• System requiring acknowledgement. 

• System, without acknowledgement. 

Configure the following basic settings for message classes: 

• the assigned message types 

• the acknowledgement philosophy and the corresponding status texts 

• the output of acoustic / optical signals 

OS compilation 

Through OS compilation the chronological messages are transferred to the 
WinCC project. In this process the messages which are configured in STEP 
7 are created in WinCC Alarm Logging and the corresponding WinCC 
message classes and message types are used. 

Thus there is an assignment of the STEP 7 message classes to the WinCC 
-message classes and message types. 

In order to make possible that the messages which were configured in 
STEP 7 are displayed in WinCC at runtime, you have to create in WinCC 
Alarm Logging the message classes and message types which are used in 
STEP 7. 

Table 5-3 

STEP 7 
Message class 

Remark WinCC
Messa

ge 
class 

WinCC
Messa

ge 
type 

WinCC name 
Message class > 

message type 

Alarm - high  1 1 Alarm > Alarm High 

Alarm - low  1 2 Alarm > Alarm Low 

Warning - high  2 19 Warning > Warning High 

Warning - low  2 20 Warning > Warning Low 

Tolerance - high  3 37 Tolerance > Tolerance 
High 

Tolerance - low  3 38 Tolerance > Tolerance 
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STEP 7 
Message class 

Remark WinCC
Messa

ge 
class 

WinCC
Messa

ge 
type 

WinCC name 
Message class > 

message type 

Low 

AS control system 
message - fault 

 4 55 AS control system 
messages > fault 

AS control system 
message - error 

 4 56 AS control system 
messages > error 

OS control system 
message - fault 

 5 71 OS control system 
messages > fault 

 Not used by STEP 
7 

5 72 OS control system 
messages > error 

Preventive 
maintenance - general 

 6 89 Preventive maintenance > 
Maintenance 

Process message - 
with 
acknowledgement 

 7 106 Process message > 
process message 

Process message - 
without 
acknowledgement 

Without 
acknowledgement 
(NOTIFY_8P) 

8 122 Operational message > 
process message 

Operator input request 
- general 

Without 
acknowledgement 
(NOTIFY_8P) 

9 139 Operator input request > 
operator input request 

Operator message - 
general 

Without 
acknowledgement 
(NOTIFY_8P) / 
gone without 
message (not in 
message list) 

10 156 Operator message > 
operator message 

Status message - AS Without 
acknowledgement 
(NOTIFY_8P) / 
gone without 
message (not in 
message list) 

16 253 Status message > status 
AS 

Status message - OS Without 
acknowledgement 
(NOTIFY_8P) / 
gone without 
message (not in 
message list) 

16 254 Status message > status 
OS 

 Not used by STEP 
7 

17 257 System, requiring 
acknowledgement > 
control system 

 Not used by STEP 
7 

17 258 System, requiring 
acknowledgement > 
system messages 
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STEP 7 
Message class 

Remark WinCC
Messa

ge 
class 

WinCC
Messa

ge 
type 

WinCC name 
Message class > 

message type 

 Not used by STEP 
7 

18 273 System, without 
acknowledgement/control 
system 

 Not used by STEP 
7 

18 274 System, without 
acknowledgement/operato
r messages 

 

NOTE If in STEP 7 chronological message classes are used whose 
respective WinCC message class and message type have not been 
created there will be no error message upon the OS compilation but 
these messages will not be displayed in runtime either. 

In that case you will find entries "Invalid message number " in the 
WinCC log file "...\SIEMENS\WinCC\Diagnose\WinCC_Sys_0x.log". 

 

5.4 Symbol-related messages 

Symbol-related messages (SCAN) are directly assigned to a signal in the 
symbol table. Admissible signals are exclusively Boolean operands: i.e. 
inputs (I), outputs (O) and memory bits (M).  

You can assign to these signals various attributes, message texts and up to 
10 associated values in the message configuration. The selection of signals 
from the symbol table is made easier for you by setting filters. 

You can scan a signal in a preset time interval with a symbol-related 
message to determine whether a signal change has occurred. 

 

Notes The time interval depends on the used CPU. 

In the event of rapid signal changes (the signal which is to be monitored 
changes faster than the scan interval) messages can get lost. 

Symbol-related messages cannot be simulated with S7-PLCSim. 
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Overview of the message processing 

The following figure schematically shows the principle of operation of the 
scan messages in WinCC: 

 

Figure 5-1 
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5.4.1 Configuring scan messages 

Table 5-4 

Step Action 

1.  Open the symbol table. 

2.  Open the symbol editor and select "View > Columns R, O, M, C, CC". 
The respective attributes can be set via the properties dialog "Special Object 
Properties" of a symbol. Select the attribute "Message" to make the symbol available 
as scan message in WinCC. 
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Step Action 

3.  Assign the message text, info text, message class, priority and type of 
acknowledgement for your scan message now. 
Notes: 
The message number is automatically assigned by the system. 
The texts must not be longer than 255 characters. 

4.  Add to your message additional associated values (max. 10) if required. You can 
only select operands from the symbol table. You can specify different time intervals 
depending on the control. 
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Step Action 

5.  Generate the SDBs via "Edit > Generate SDB". Alternatively, the SDBs are also 
automatically created when the symbol table is saved. 

6.  Result: The messages were stored in SDB 305.  
The numbering of the SDBs 3xx depends on the selected time interval: 
SDB 301 to SDB 304: 100 ms 
SDB 305 to SDB 312: 500 ms 
SDB 313 to SDB 320: 1000 ms 

 

5.4.2 Compiling 

To transfer the changes to WinCC a compilation must be started. For more 
information refer to the Chapter  3.6. 
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5.5 Block-related messages 

Block-related messages are assigned to a block (instance DB). You can 
use system function blocks (SFBs) and system functions (SFCs) as 
message blocks to create a block-related message. 

 

Overview of the message processing 

The following figure schematically shows the principle of operation of the 
block-related messages in WinCC: 

 

Figure 5-2 
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Instance concept of the message block 

The following figure schematically shows the type instance of a message 
block: 

 

Figure 5-3 
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5.5.1 Configuring messages with "ALARM_S(Q)" 

Table 5-5 

Step Action 

1.  You have to declare corresponding parameters in the variable declaration table for 
each message block which is called in FB: 

 For the parameter "IN" a symbolic name for the message block input of the data 
type "DWORD", e.g. "Meld_Alarm_S". 

 For the parameter "STAT" a symbolic name for the message block to be called 
with the corresponding data type, e.g. "SFC18" for Alarm_S (see also Table 
5.3.3.). 

 
Invoke the "Object Properties" of an interface symbol in the declaration part via the 
properties dialog then. 
 
Note: 
Only IN, OUT and IN_OUT parameters can be assigned a message attribute. 
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Step Action 

2.  Append the following system attributes for the parameters: 
"S7_server" and "S7_a_type". 
 
Assign to the system attributes the values which correspond to the message blocks 
which were called in your program code. The value for "S7_server" is "alarm_archiv" 
as a rule, the value for "S7_a_type" corresponds to the called message block, i.e. 
"alarm_s" here. 

 
3.  Program the calling of the message block in the statement section of the FB. 

Connect the parameters of the system message block with the respective I/Os of the 
function block. 
Save the function block then. 
 
Notes: 
The parameter "SIG" initiates the message. 
The parameter "ID" is permanently assigned the value "W#16#EEEE". 
The parameter "EV_ID" gets the message number generated by the system. 
You can use the parameter "SD" to configure an associated value. 
The parameter "RET_VAL" contains error information. 

4.  Call the function block in your program. 
Note: 
The IDs for the messages are automatically generated by STEP 7. These IDs must 
not be changed! 
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Step Action 

5.  Select the instance data block of the FB in the SIMATIC Manager. Go to "Special 
Object Properties > Message..." in the context menu. 

 

6.  Input the message text for the messages. 
 
Note: 
You can either input the message text directly in the field "Message text" or, as 
shown in the figure, input a reference to the text library. 
For further information, please refer to Chapter 5.5.7 . 
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5.5.2 Compiling 

To transfer the changes to WinCC a compilation must be started. For more 
information refer to the Chapter 3.6. 



 
Messages

WinCC – Examples of integrated engineering with STEP 7  Entry ID: 34995306

 

Version V1.0 Issue 27.04.2009 75/230
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 C
o

p
yr

ig
h

t 
20

09
 A

ll 
rig

h
ts

 r
e

se
rv

ed
 

   

5.5.3 Configuring messages with "ALARM_8P" 

Table 5-6 

Step Action 

1.  You have to declare corresponding parameters in the variable declaration table for 
each message block which is called in FB: 

 For the parameter "IN" a symbolic name for the message block input of the data 
type "DWORD", e.g. "EV_ID1" and the required signals "SIG_x" and associated 
values "SD_x". 

 For the parameter "STAT" a symbolic name for the message block to be called 
with the corresponding data type, e.g. "SFB35" for Alarm_8P (see also Table 
5.3.3.). 

 
Invoke the "Object Properties" of an interface symbol in the declaration part via the 
properties dialog then. 
 
Note: 
Only IN, OUT and IN_OUT parameters can be assigned a message attribute.  
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Step Action 

2.  Append the following system attributes for the parameters: 
"S7_server" and "S7_a_type". 
 
Assign to the system attributes the values which correspond to the message blocks 
which were called in your program code. The value for "S7_server" is "alarm_archiv" 
as a rule, the value for "S7_a_type" corresponds to the called message block, i.e. 
"alarm_8p" here. 

 
3.  Program the calling of the message block in the statement section of the FB. 

Connect the parameters of the system message block with the respective I/Os of the 
function block. 
Save the function block then. 
 
Notes: 
The parameters "SIG1" to "SIG8" initiate the messages. 
The parameter "ID" is permanently assigned the value "W#16#EEEE". 
The parameter "EV_ID" gets the message number generated by the system. 
You can use the parameters "SD1" to "SD8" to configure 
associated values. 
The parameters DONE, ERROR, STATUS and ACK_STATe inform 
about processing, error and alarm statuses. 
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Step Action 

4.  Call the function block in your program. 
Note: 
The IDs for the messages are automatically generated by STEP 7. These IDs must 
not be changed! 
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Step Action 

5.  Select the instance data block of the FB in the SIMATIC Manager. Go to "Special 
Object Properties > Message..." in the context menu. 
Input the message text for the messages. 

 
 

5.5.4 Compiling 

To transfer the changes to WinCC a compilation must be started. For more 
information refer to the Chapter 3.6. 

 

5.5.5 Buffering messages with "ALRM7PBT" 

On the one hand the "ALRM7PBT" function block can be used to transfer 
events from subsystems to WinCC buffered with existing time stamps. On 
the other hand local events can be processed with or without existing time 
stamp. 



 
Messages

WinCC – Examples of integrated engineering with STEP 7  Entry ID: 34995306

 

Version V1.0 Issue 27.04.2009 79/230
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 C
o

p
yr

ig
h

t 
20

09
 A

ll 
rig

h
ts

 r
e

se
rv

ed
 

   

Application areas 

The common alarm mechanisms "Alarm_8" and "Alarm_8P" can be used to 
transfer status changes of events/alarms to the WinCC system together 
with a time stamp. This time stamp refers to the time when the alarm block 
was invoked and not to the time when the event/alarm occurred. 

"Alarm_8" and "Alarm_8P" can intermediately store two status changes of 
an event/alarm. Other status changes would get lost, for instance, upon a 
communication failure.  

Whenever this system response is not sufficient, the solution described 
here can be used successfully: 

 Certain applications entail the request to provide events/alarms which 
occur in subordinated systems with the original time stamp there and to 
transfer them together to WinCC via a central S7-400 control, e.g. 

– for hierarchical control topologies with subordinated S7-300 which 
do not support "Alarm_8",  

– signal time stamping in the ET 200M,  

– remote control. 

 In the power plant field or Konti processes alarms should not get lost 
even if the coupling is disturbed temporarily or WinCC is not ready for 
receiving alarms. 
 
The "regular" alarm mechanisms of an S7-400 control can only store 
intermediately two status changes of an alarm; e.g.   

– Alarm1: max. pressure of boiler 002KOG1 exceeded  

– Alarm2: max. pressure of boiler 002KOG1 exceeded, going 

Other status changes of the alarm signal would get lost, for instance, upon 
a communication failure. 

Solution with the block ALRM7PBT 

The ALRM7PBT block made available here acquires and buffers 
events/alarms with the corresponding time stamps and two associated 
values and transfers them to WinCC then. 

For sending the events the ALRM7PBT block uses internally an 
"ALARM_8P" instance. The acquisition and the sending of the events are 
asynchronous. 

The buffering ensures that events will not get lost even in the event of a 
rush of messages or temporary communication failures. 

 

If the buffering capacity of the "ALRM7PBT" should not be sufficient, e.g. 
due to a prolonged communication failure (cable break), the signal 8 
(SIG_8) of the internally invoked "ALARM_8P" block is used for the 
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message "Buffer overflow coming". New further events are also acquired 
and stored if the buffer is full; the oldest events will be overwritten and get 
lost. After the communication fault has been remedied, the "ALRM7PBT" 
block signals "Buffer overflow going". 

The internally used "ALARM_8P" is only invoked if the events have to be 
sent. After all buffered events have been processed, the "ALARM_8P" 
block is no longer invoked - which, ultimately, saves cycle time but which 
also means that acknowledgements from HMI cannot be evaluated by the 
user program.  

Restart response: 

A specific start behaviour has not been implemented in the block. If the 
user wants to reset the internal message buffer during the start, he has to 
invoke the respective "ALRM7PBT" instance in the restart OB himself and 
to reset it via the parameter "RESET". 

Compatibility: 

The block is executable on controls which support the "ALARM_8P". 

The "ALRM7PBT" exclusively uses standard mechanisms. Thus no special 
software is required on the WinCC side. 

List of interfaces: 

Table 5-7 

Parameters Declaration Data 
type 

Memory 
area 

Description 

EN_SEND INPUT BOOL E, A, M, D, 
L, konst 

Enable for sending 
the events to the 
HMI 

EN_READ INPUT BOOL E, A, M, D, 
L, konst 

Enable for acquiring 
the events 

RESET INPUT BOOL E, A, M, D, 
L, konst 

Resetting the 
instance DB and 
thus the buffer 

EXT_TS INPUT BOOL E, A, M, D, 
L, konst 

TRUE:  
Using the 
transferred external 
time stamps  
 
FALSE:  
Creating time stamp 
internally 

SIG_i INPUT BOOL E, A, M, D, 
L, konst 

i-th signal to be 
monitored, positive 
and negative edges 
cause the 
acquisition of the 
coming/going events 
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Parameters Declaration Data 
type 

Memory 
area 

Description 

EXT_TSi_DT INPUT DT D, L, konst i-th time stamp to be 
transferred 

EV_ID_T INPUT DWORD E, A, M, D, 
L, konst 

Message number; 
automatically 
assigned by the S7 
message number 
server. 

SEND_DELAY INPUT TIME E, A, M, D, 
L, konst 

Time distance of two 
successive 
messages; 
reduces the 
message load, e.g. 
after logging-on of 
HMI station 

SD_1 INPUT REAL E, A, M, D, 
L, konst 

1. Associated value 
of the message 

SD_2 INPUT REAL E, A, M, D, 
L, konst 

2. Associated value 
of the message 

ENTRIES OUTPUT INT E, A, M, D, 
L, konst 

Number of currently 
buffered events 

BUFFER_OV OUTPUT BOOL E, A, M, D, 
L, konst 

Buffer overflow 

ERROR OUTPUT BOOL E, A, M, D, 
L, konst 

Error of the 
ALARM_8P 

STATUS OUTPUT WORD E, A, M, D, 
L, konst 

Status of the 
ALARM_8P 
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Parameter declaration: 

Figure 5-4 
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System attributes for the parameters: 

Figure 5-5 

 

 

5.5.6 Entering associated values in messages 

To append current information, e.g. of the process, to block-related and 
symbol-related messages you can insert associated values at any points of 
a message text. 

Procedure: 

 Put together a block with the following structure: 
@<No. of the associated value><element type><format>@. 

 Insert this block at positions in the message text where the associated 
value is to be displayed. 
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Element type: 

Used to uniquely configure the data type of the associated value: 

Table 5-8 

Element type Data type 

Y BYTE 

W WORD 

X DWORD 

I INTEGER 

D INTEGER 

B BOOL 

C CHAR 

R REAL 

 

The element type only makes unique the data type which is transferred by 
the AS. It is not used as casting operator. 

Format: 

Determine the output format of the associated value on the output device. 
The format output is started with the character "%". The following fixed 
formats exist for message texts: 

Table 5-9 

Format Description 

%[i]X Hexadecimal number with i digits 

%[i]u Decimal number, unsigned 
with i digits. 

%[i]d Decimal number, signed 
with i digits. 

%[i]b Binary number with i digits. 

%[i][.y]f Fixed point number 
Signed value of the form 
[ - ]dddd.dddd 
dddd: one or several numbers with y 
digits after the decimal point and i total 
digits. 

%[i]s Character string (ANSI string) with i 
digits 
Characters are printed up to the first 0 
byte 
(00Hex). 

%t#<name of text library> Access to text library. 
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If the format display is too short, the value will be output in full length 
nevertheless.  

If the format display is too long, a matching number of blanks will be output 
in front of the value. 

Note Please note that you can enter "[i]" optionally where the squared brackets 
have to be left out when you enter the i.  

 

Examples of associated values: 

 @1I%6d@: The value of the associated value 1 is displayed as a 
decimal number with maximally 6 digits. 

 @2R%6f@: The value "5.4", for instance, of the associated value 2 is 
displayed as fixed point number "5.4" (three leading blanks). 

 @2R%2f@: The value "5.4", for instance, of the associated value 2 is 
displayed as fixed point number "5.4" (no cutting if the number of digits 
is too small). 

 @1W%t#Textbib1@: Associated value 1 of data type WORD is the 
index. 

 

Note For S7-PDIAG "C" must be specified as the element type for CHAR and 
"R" for REAL as a rule. "X" must be given for the other element types 
BOOL, BYTE, WORD, INT, DWORD and DINT valid for S7-PDIAG as a 
rule. 

If you want to append to one of the ALARM_S blocks more than one 
associated value, you can append an array with maximally 12 bytes 
length. This can be, for instance, maximally 12 bytes or chars, maximally 
6 Word or Int or maximally 3 DWord, Real or DInt. 
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Message with associated value: 

Figure 5-6 

 

 

5.5.7 Using text libraries 

There are two types of text libraries to create or edit messages:  

 User text libraries 

 System text libraries 

System text libraries and user text libraries provide a list of texts which can 
be integrated into messages, updated dynamically in runtime and displayed 
on the PU or other output devices. 

Messages in system text libraries and user text libraries can be compiled 
externally. 

You can integrate any number of texts from maximally four different text 
libraries into one message. The texts can be placed freely, therefore it is 
possible to also use them in messages in other languages. 

Procedure: 

 In the SIMATIC Manager select the CPU or an object which is 
subordinated to the CPU and select the menu option "Options > Text 
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Libraries > System Text Library" or "Options > Text Libraries > User 
Text Library" to open a text library. 

 Determine the index of the text which you want to integrate. 

 Enter a wildcard with the format @[Index]%t#[Textbib]@ at the position 
in the message where the text is to appear. 

Note [Index] = e.g. 1W, where 1W is the first associated value of the message 
with the type WORD. 

 

NOTE You can only integrate texts into messages from user text libraries if 
you have selected the assignment of the message numbers used 
CPU-wide. 

 

Example: 

Configured message text: Pressure has increased @2W%t#Textbib1@. 
Text library with the name "Textbib1": 

Table 5-10 

Index German French 

1734 zu hoch trop haut 

 

Translating text libraries: 

The texts in system text libraries are provided by STEP 7 or STEP 7-option 
packages. There can be several text libraries for one CPU which can be 
translated to the required languages. 

The languages which are available in a project can be selected via "Options 
> Language for Display Devices" in the SIMATIC Manager. It is also 
possible to add or delete languages later. 

If you want to translate a text library via "Options > Manage multilingual 
texts > Export", an export file is created which you can edit, for instance, 
with Microsoft EXCEL. After opening it a table is displayed whose columns 
give different languages. For further information refer to the Chapter  5.6.1. 

NOTE An export file in the CSV format must not be opened with a double-
click on the file. Open this file via "File > Open" in Microsoft EXCEL 
instead. 
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Creating user text libraries: 

Table 5-11 

Step Action 

1.  Add a new user text library via "Insert > Text Library > User Text Library". 

 
2.  Open the text library. 

3.  Create the texts in the text library. 
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Message text from the text library: 

Figure 5-7 

 

 

5.6 Language settings 

STEP 7 supports several languages for the creation of messages. 

When you create messages the language settings in STEP 7 must comply 
with those of WinCC. 

If different languages have been selected, inconsistencies may result 
during the translation. 
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Procedure: 

Table 5-12 

Step Action 

1.  Select "Options > Language for Display Devices...". 

 
2.  Select a language via the "Set as Default" button. 
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Step Action 

3.  Open "Alarm Logging" in WinCC. 

 
4.  Open the selection window via "View > Language...". 
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Step Action 

5.  Select the same language as in STEP 7. 

 
 

5.6.1 Translating and editing user-relevant texts 

Texts which are output on display devices during the process execution are 
usually input in the language in which the automation solution was 
programmed.  

However, it frequently occurs that an operator who has to respond to the 
messages does not understand this language.  

STEP 7 offers the option to translate all operator-relevant texts to any 
language. For that purpose the desired language must have been installed 
in your project already. 

The languages which are available in a project can be selected via "Options 
> Language for Display Devices" in the SIMATIC Manager. It is also 
possible to add or delete languages later. 

If you want to translate a text library via "Options > Manage Multilingual 
Texts > Export...", an export file is created which you can edit, for instance, 
with Microsoft EXCEL. After opening it a table is displayed whose columns 
give different languages. 

After the export file has been processed in Excel you can reimport the 
revised export file to your project via "Options > Manage Multilingual Texts 
> Import...". 
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Table 5-13 

Step Action 

1.  Create an export file via "Options > Manage Multilingual Texts > Export". 

 
2.  Select a storage path and a suitable format. 



 
Messages

WinCC – Examples of integrated engineering with STEP 7  Entry ID: 34995306

 

Version V1.0 Issue 27.04.2009 94/230
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 C
o

p
yr

ig
h

t 
20

09
 A

ll 
rig

h
ts

 r
e

se
rv

ed
 

   

Step Action 

3.  Open the file in Excel to edit it. 
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5.7 Further reading 

Bibliographic references 

This list is not complete and only represents a selection of relevant 
literature. 

Table 5-14 

 Topic Title 

/1/ STEP7 V5.4 
Documentation 
Basic 
Knowledge 

6ES7810-4CA08-8AW0 

/2/ Documentation 
of WinCC V7.0 

http://support.automation.siemens.com/WW/view/en/29
489481 

Internet links 

This list is not complete and only represents a selection of relevant 
literature. 

Table 5-15 

 Topic Title 

\1\ Using message 
classes 

http://support.automation.siemens.com/WW/view/de/31
622970 

\2\ Using 
associated 
values 

http://support.automation.siemens.com/WW/view/de/24
013249 

\3\ Buffering of 
messages 

http://support.automation.siemens.com/WW/view/de/20
614217 

\4\ Siemens I IA/DT 
Customer 
Support 

http://support.automation.siemens.com 

 

https://support.automation.siemens.com/WW/llisapi.dll?query=6ES7810-4CA08-8AW0&func=cslib.cssearch&content=skm%2Fmain.asp&lang=de&siteid=csius&objaction=cssearch&searchinprim=&nodeid99=�
http://support.automation.siemens.com/WW/view/en/29489481�
http://support.automation.siemens.com/WW/view/en/29489481�
http://support.automation.siemens.com/WW/view/en/31622970�
http://support.automation.siemens.com/WW/view/en/31622970�
http://support.automation.siemens.com/WW/view/en/24013249�
http://support.automation.siemens.com/WW/view/en/24013249�
http://support.automation.siemens.com/WW/view/en/20614217�
http://support.automation.siemens.com/WW/view/en/20614217�
http://support.automation.siemens.com/�
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6 Diagnostics 

6.1 Introduction 

To stay internationally competitive in the industry, the continuous 
minimization of the production costs is decisive for the operators of plants 
and processes. Downtimes of production plants will lead to production 
losses and consequently they are an important cost factor. 

The purpose of diagnostics is to reduce this cost factor decisively. 

Types of diagnostics 

Principally, two different origins are distinguished for the occurrence of 
faults and, accordingly, for the diagnostics: 

 System diagnostics 
Detection, signalling and evaluation of faults within the automation 
system (e.g. wire break, module failure, program error, etc.) 

 Process diagnostics 
Detection, signalling and evaluation of faults outside the automation 
system (e.g. movement disturbed, locking not effected, pressure too 
high, etc.). 

Here it must be taken into account that a system error can usually lead to 
several process errors. 

Display of the diagnostics 

In runtime and during service the operator or service personnel must be 
able to determine and remove the error cause without a programming 
device and without programming knowledge. 

Note As an alternative to the local in-situ diagnostics the WinCC/WebNavigator 
provides the option to get an overview over the plant with access via the 
internet. 

A WinCC diagnostics licence permits to perform management and 
remote maintenance services sequentially for many WinCC plants via a 
WinCC webserver from a small number of central remote maintenance 
computers. 

The licensing is performed on each diagnostics client instead of the 
WinCC/WebNavigator server. 
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Overview of the diagnostics 

The following figure schematically shows the structure of the components 
involved in the diagnostics: 

Figure 6-1 
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6.2 System diagnostics 

Diagnostics with organisation blocks 

Organisation blocks (OBs) are the interface between the operating system 
and the user program. They are invoked by the operating system and they 
control the cyclic and interrupt-driven program execution, the start response 
of the automation system and the error handling. You can program the 
organisation blocks and determine the response of the CPU in this way. 

The errors which the S7 CPUs detect and to which you can respond with 
the help of organisation blocks can be divided into two categories: 

 Asynchronous error OBs 

 Synchronous error OBs 

6.2.1 Asynchronous error OBs 

Theses errors cannot be assigned directly to the processed user program. 
They are priority class errors, errors in the automation system (e.g. 
defective modules) or redundancy errors. If the respective asynchronous 
error OB has not been loaded, the CPU proceeds to STOP when the error 
occurs (exceptions: OB 70, OB 72, OB 81, OB 87). 

Using the OBs for asynchronous errors 

When the CPU operating system detects an asynchronous error, it starts 
the respective error OB (OB 70 to OB 73 and OB 80 to OB 87). The OBs 
for asynchronous errors have the highest priority preset for them: They 
cannot be interrupted by other OBs when all asynchronous error OBs have 
the same priority. If several asynchronous error OBs with the same priority 
occur simultaneously, they are processed in the order in which they 
occurred. 

Note To ignore alarms it is more efficient to lock them with SFC in the start 
instead of loading an empty OB (with the content BE). 

For more information on this and on the individual organisation blocks 
refer to the reference manual "System Software for S7-300/400 System 
and Standard Functions": 

http://support.automation.siemens.com/WW/view/en/1214574 

 

http://support.automation.siemens.com/WW/view/en/1214574�
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Overview of the asynchronous errors 

Table 6-1 

OB Triggering event 

70 Peripheral redundancy error (only H-CPUs) 

72 CPU redundancy error (only in H-CPUs, e.g. CPU failure) 

80 Time error (e.g. cycle time exceeded) 

81 Power supply error (e.g. battery fault) 

82 Diagnostic alarm (e.g. short circuit in the input module) 

83 Pull / plug alarm (e.g. pulling an input module) 

84 CPU hardware error (error at the interface to the MPI network) 

85 Program sequence error (e.g. OB not loaded) 

86 Module rack failure 

87 Communication error (e.g. wrong message identification in global data 
communication) 

 

Delaying or locking start events 

You can use the system functions (SFC) to delay or lock start events for 
some error OBs. 

Table 6-2 

SFC Function 

39 Locking alarm and asynchronous error events in general. Locked error 
events will not start in any of the subsequent CPU cycles, error OBs 
and will not lead to the programmed alternative reaction. 

40 Enabling alarm and asynchronous error events. 

41 Delaying alarm and asynchronous error events with a higher priority up 
to the OB end. 

42 Enabling alarm and asynchronous error events with a higher priority. 
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6.2.2 Synchronous error OBs 

Theses errors can be assigned to a certain part of the user program. The 
error is triggered by a certain operation during the processing. If the 
respective synchronous error OB has not been loaded, the CPU proceeds 
to STOP when the error occurs. 

Using the OBs for synchronous errors 

Synchronous errors are caused during the processing of a certain 
operation. When these errors occur, the operating system creates an entry 
in the U-stack and starts the OB for synchronous errors.  

The error OBs which are invoked by synchronous errors are processed as 
part of the program in the same priority class as the block which is 
processed when the error is detected. The details of the error which 
triggered the OB call are given in the start information of the OB. You can 
use this information to respond to the error condition and return to the 
processing of your program (e.g. specify a substitute value with SFC 44 
RPL_VAL in the case of access errors to an analog input module in OB 
122). However, this also means an extra load on the L-stack of this priority 
class from the local data of the error OBs. 

When S7-400 CPUs are used another synchronous error OB can be 
started from out of a synchronous error OB. With S7-300 CPUs this is not 
possible. 

Note To ignore alarms it is more efficient to lock them with SFC in the start 
instead of loading an empty OB (with the content BE). 

For more information on this and on the individual organisation blocks 
refer to the reference manual "System Software for S7-300/400 System 
and Standard Functions". 

 

Overview of the synchronous errors 

Table 6-3 

OB Triggering event 

121 Programming error (e.g. DB not loaded) 

122 Peripheral access error (e.g. access to a signal module which does not 
exist) 
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Masking of start events 

You can mask the start events with system functions (SFC). 

Table 6-4 

SFC Function 

36 Masking individual synchronous error events. Masked error events do 
not start any error OBs and do not lead to any programmed alternative 
reaction. 

37 Demasking synchronous error events. 

 

6.2.3 Bus diagnostics in the control 

Internally available diagnostic information 

Table 6-5 

OB / 
SFC 

Application 

OB82 Diagnostic alarm 

OB86 Module rack failure 

SFC13 Reading the diagnostic data (Slave diagnostics) of a DP slave 

SFC49 Determines the slot of a logic address 

SFC5 Determining the logic base address of a module 

SFC51 Evaluation of the diagnostic buffer (reading out an SSL part list) 
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S7 standard blocks 

The diagnostics package PNIODiag was created to simplify the diagnostics 
evaluation of distributed I/O modules in connection with S7 SIMATIC. The 
diagnostics evaluation is done both for PROFIBUS DP systems and also 
for PROFINET IO systems. 

At present there are two variants:  

 S7 block for CPUs with a storage capacity of S7 blocks > 16 KB  

 S7 block for CPUs with a storage capacity of S7 blocks <= 16 KB 

The operation and evaluation of the diagnostics is done entirely via the 
visualization. 

The FB126 provides the following functions:  

 Overview over the statuses of the connected I/O systems  

 Overview over the station statuses of an I/O system  

 Diagnostics display for diagnostics repeaters  

 Detailed display of the station status - deactivating / activating stations.  

 Triggering diagnostic events of a station  

 Event memory 

A sample project including the function block and the corresponding 
documentation are given at this link: 

http://support.automation.siemens.com/WW/view/en/26996747 

 

http://support.automation.siemens.com/WW/view/en/26996747�
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Table 6-6 

Step Action 

1.  Call the function block in your program. 

2.  Start the WinCC project. With the "legend" and "trigger" buttons you can open the 
respective screens. 
In this example the DP master system 1 and the PNIO system 100 are used. 
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Step Action 

3.  You can select the screen "Legend" from the screens "Station Overview", "Activate / 
Deactivate" and "System Overview". 
The screen "Legend" shows the different statuses of the stations. 
The screen "System Overview" shows the same view, only the status "deactivated" 
is not displayed. 
By clicking the "back" button you can return to the previous screen. 



 
Diagnostics

WinCC – Examples of integrated engineering with STEP 7  Entry ID: 34995306

 

Version V1.0 Issue 27.04.2009 105/230
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 C
o

p
yr

ig
h

t 
20

09
 A

ll 
rig

h
ts

 r
e

se
rv

ed
 

   

Step Action 

4.  In the screen "Station Overview" you can see the status of each station of the 
selected system. There is a separate button for each station. 
Each button has an inner and an outer zone. The inner zone shows the actual status 
of the station, the outer zone has a storage function.  
If the station is faultless, the outer zone shows whether an event has taken place 
since the station overview was reset last. 
The meaning of the colours and the displayed information is given in the screen 
"Legend". The current system ID is displayed at the upper screen edge. 
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Step Action 

5.  General information about the station is displayed in the upper part of the screen 
"Station Diagnostics". The information includes: 

 ID of the system 

 Station number 

 Status of the station 

 Manufacturer ID 

 Station ID 

 Number of pending error, sorted by error type and number of errors 
 
Detailed information about the station is given in the lower part of the screen. 

 

6.2.4 Diagnostic tools 

System diagnostics 

This WinCC premium add-on can be used to configure a diagnostic 
environment for your Operator Station. This station will then be capable of 
providing detailed information about PROFIBUS DP slaves, PROFINET IO 
devices and S7 400 CPUs. 
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Overview of the system diagnostics 

The following figure schematically shows the principle of operation of the 
premium add-on in WinCC: 

Figure 6-2 

 

 

 Configuration in STEP 7: 

– Calling the diagnostic block in the S7 program 

– Export of the hardware configuration (cfg file) 

– Transfer of the block variables to WinCC (AS-OS transfer) 

 Configuration in WinCC: 

– Entering the diagnostics OCX in the WinCC screen 

– Binding the transferred block variables to the diagnostics OCX 

– Specifying the storage path of the exported HW configuration (cfg 
file) 

Principle of operation 

The add-on consists of maximally five STEP 7 blocks and one ActiveX-
Control (faceplate). The STEP 7 blocks acquire the information of the 
configured master system and send these data to WinCC. 

http://www.siemens.de/systemdiagnose 

http://www.siemens.de/systemdiagnose�
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6.2.5 Report System Error 

With the function "Report System Error" (SFM) STEP 7 provides a 
convenient option to display diagnostic information in the form of 
messages. The blocks and message texts required for this are generated 
automatically by STEP 7. The user merely has to load the created blocks to 
the CPU and transfer the messages into the WinCC-project. 

Features 

 Report System Error is a block-based S7 mechanism 
for diagnosing and reporting system errors of an 
S7 automation system 

 Report System Error is an integral part of STEP 7 

 No additional licence (apart from the STEP 7 licence) is required  

 SFM is based on the following system functions: 

– Diagnosis: SFC 13, 51, 59  SFB 52, 54 

– Report:  SFC 17&18, 107&108 Alarm_S&D 

 SFM was integrated in STEP 7 with V5.1 in August 2000 

 Since then the SFM has been extended and improved gradually: 

– STEP 7 V5.3:  Support of PROFINET 

– STEP 7 V5.4 SP2: Optimization of the required cycle time  

– STEP 7 V5.4 SP4: Support of the CPU web server (DB 127) 

Required steps 

Table 6-7 

Step Action 

1.  Configure hardware as usual 

2.  Select CPU 

3.  Open “Report System Error” 

4.  Create messages 

5.  Determine program integration (OBs) 

6.  Start SFM generation 

7.  Load S7 data into the CPU 

8.  Transfer HMI data into the HMI device 
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Overview of the system diagnostics 

The following figure schematically shows the principle of operation of 
"Report System Error" (SFM): 

Figure 6-3 
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Table 6-8 

Step Action 

1.  Open HW Config of the CPU, select the CPU and open the menu "Options > Report 
System Error…". 
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Step Action 

2.  Adjust the settings of SFM (in general the default values are specific enough). Start 
the generation of SFM by pressing the "Generate" button. 

3.  SFM creates the blocks "FB49", FC49, DB49" and "DB50". 
These blocks have to be reloaded to the CPU after every generation and the CPU 
has to be switched from "STOP" to "RUN" then. 
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Step Action 

4.  Integrate the SFM blocks "FB49" and "DB49" into your program. 

 
5.  Further the SFM creates all necessary messages which contain the information that 

is supplied by the system. These messages can either be exported in the SFM 
settings dialog... 
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Step Action 

6.  ...or checked in DB 49 via "Special Object Properties > Message...". 

 

Note The DB125 is updated by the SFM blocks, therefore the  
FB125 may be dropped. The blocks FB/DB125 created for the 
diagnostics screens for Profibus DP are compatible with it. 

 

NOTE The DB126 which is generated by SFM cannot be used with the  
diagnostics screens for Profinet IO (FB/DB126). 

 

Note The DB127 which is generated by SFM contains the diagnostics data for 
the CPU web server. 

6.2.6 Compiling 

To transfer the changes to WinCC a compilation must be started. For more 
information refer to the Chapter 3.6. 
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6.2.7 SIMATIC Maintenance Station 

The SIMATIC Maintenance Station is an option package for WinCC and 
facilitates a unique diagnostics of the plant components, the so-called 
assets, for the maintenance field. Another benefit of the Maintenance 
Station is the plant automation and maintenance combined in one system. 
This also simplifies the handling as only one system is used for 
configuration and the operator control and monitoring of the plant. 

Note Note in this connection also the extended diagnostics options of the Basic 
Process Control in Chapter 7. 
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Terms 

 Asset 
Assets are the individual components of a company. The term "plant-
oriented assets" describes components or devices of the plant or 
machines on which maintenance is carried out. 

 Asset Management 
The term asset management summarizes general activities and 
measures which maintain or increase the value of a plant. These 
measures do not only include the production management and plant 
automation and their optimization but, in particular, also the value-
maintaining or value-increasing maintenance. 
 

 Plant-oriented Asset Management 
The value-maintaining or value-increasing maintenance is also called 
plant-oriented asset management. What is particularly important is the 
relationship, which is to be as optimal as possible, between the efforts 
for value-increasing maintenance and the availability of the plant. 
The plant-oriented asset management does not only comprise the 
collection of information so that the technical plant condition can be 
assessed but also the decision and execution of maintenance 
measures. 
 

 Plant-oriented asset management system 
A plant-oriented asset management system is an EDP system which 
has the following functions: 

– Collecting online information for assessment of the plant and 
component conditions 

– Support of decision about maintenance measures 

– Preparation and execution of maintenance measures 

– Interfaces to other systems for asset management, e.g. EAM/CMMS 
or business management 
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Overview of SIMATIC Maintenance Station 

The following figure schematically shows the structure of the components 
involved in the diagnostics: 

Figure 6-4 

 

 

Principle of operation 

The PLC alarms are created by the CPU as a system functionality based 
on STEP 7 "Report System Error". They are available for central SIMATIC 
control components and for PROFIBUS and PROFINET IO standard 
devices. 

The user configures the Maintenance Station by selecting in STEP 7 the 
automation systems to be imaged in the hardware configuration. Based on 
this configuration the Maintenance Station recognizes the devices which 
belong to the plant and it creates an image for maintenance in WinCC.  
The project automatically creates itself in the form of hierarchically 
structured and completely interconnected WinCC images and it will be 
subsequently automatically transferred to the Maintenance Station.  
New hardware components are added to the hardware configuration of 
STEP 7 and they will be also automatically available for the Maintenance 
Station then. 
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Table 6-9 

Hierarchical plant structure 

Plant overview 
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Hierarchical plant structure 

Overview of AS stations 
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Hierarchical plant structure 

AS-Station 
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Hierarchical plant structure 

Field bus 
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Hierarchical plant structure 

Modules of a slave 

 
Details of a component 
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6.2.8 Ladder rung jump 

The ladder rung jump can be used to directly jump from WinCC runtime to 
the respective LAD / FBD / STL program editor of STEP 7 with a focus on 
the STEP 7-symbol which belongs to the process tag. This makes the 
diagnostics of failures faster and simpler. 

You can configure the ladder rung jump with or without authorization 
verification: 

 With authorization verification 
The full access to the STEP 7 program editor requires that you as the 
logged-in user have the proper authorization for the ladder rung jump in 
runtime. If you do not have this authorization, you will only have reading 
access to the blocks in the program editor. 

 Without authorization verification 
You have reading and writing access to all blocks in the program editor. 

For faster and simpler error diagnostics the user can also directly jump to 
the hardware diagnostics. 

A jump is also possible from the program editor to the images of WinCC 
where the process tag is displayed. 

The table shows the three jump variants 

Table 6-10 

Jump variants 

Ladder rung jump from WinCC runtime to the respective LAD / FBD / STL 
program editor of STEP 7. 

 
Jump from the LAD / FBD / STL program editor of STEP to the WinCC runtime 
picture where the process tag is displayed.  

 
Jump from WinCC runtime to the hardware diagnostics of the control. 
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Ladder rung jump acc. to WinCC 

Table 6-11 

Step Action 

1.  Create the current reference data. 

 
2.  Insert in the picture a graphic object, e.g. a "button" and select the object. 
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Step Action 

3.  Start the Dynamic Wizard via the menu option "View > Toolbars". Go to the tab 
"Standard Dynamics" and open the Wizard "Ladder rung jump" with a double-click. 

 
4.  The Wizard will take you through the configuration steps. Select the trigger at which 

the ladder rung jump shall be executed. Click "Next" then. 
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Step Action 

5.  Select an attribute of the object, e.g. "ToolTipText". This attribute will be linked with 
the subsequently selected tag. 

 
6.  Determine the tag now to which the ladder rung jump is to take place. Click the 

selection button for opening the tag selection dialog. Select a tag and close the 
dialog with "OK". Click "Next" then. 
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Step Action 

7.  Determine whether the STEP 7 write authorization verification shall take place at the 
ladder rung jump. If you want this verification be performed you have to determine 
the authorization level. Click "Next" then. 

 
8.  You will get another overview of the options which you selected. Check them and 

click "Finish". 
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Jump to WinCC (Show Picture) 

Figure 6-5 

 



 
Diagnostics

WinCC – Examples of integrated engineering with STEP 7  Entry ID: 34995306

 

Version V1.0 Issue 27.04.2009 128/230
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 C
o

p
yr

ig
h

t 
20

09
 A

ll 
rig

h
ts

 r
e

se
rv

ed
 

   

Jump into Hardware Diagnostics 

Figure 6-6 
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6.3 Process diagnostics 

The process diagnostics with S7-PDIAG can only be carried out in 
connection with an output device (HMI) and the corresponding software as, 
for instance, ProAgent for WinCC. 

S7-PDIAG  

S7-PDIAG facilitates the configuration of the process diagnostics for 
SIMATIC with the LAD, FBD or STL programming languages. 

The process diagnostics is used to detect faulty statuses outside the 
automation system (e.g. limit switch not reached). 

Application: 

 for failure display with user-defined text. 

 for display of the causing signal (criteria analysis) at the logic level. 

 for remedy of process errors. 

Functions: 

 Signal monitoring (incl. criteria analysis) and the corresponding 
message texts within the LAD / FBD / STL editor. 

 Configured FB call (optional) upon diagnostic event. 

 Online changes of monitoring times. 

 Option to control or change motions and modes directly from WinCC. 

ProAgent 

The option package ProAgent provides the following important functionality 
on the WinCC side on the basis of a standardized user interface (uniform 
for S7-PDIAG and S7-GRAPH): 

 Error display with time stamp and message status (e.g. coming). 

 Error detection, criteria analysis and display of the causing process 
signals. 

 Supporting error removal through motion pictures and mode switches 
with which machine parts can be moved so that errors can be remedied 
(e.g. left-right motion). 
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6.3.1 Overview of the process diagnostics 

The following figure schematically shows the process diagnostics structure 
in connection with WinCC: 

Figure 6-7 

 

 

6.3.2 Configuration procedure 

Configuration of the PLC functions 

 Programming of control function with LAD / FBD / STL 

 Defining / programming of the monitoring function with S7-PDIAG 

 Compilation of the control program and generation of the diagnostic 
functions 

 Loading the blocks into AS 

 

Configuration or parameterization of the HMI functions 

 Selection of the standard pictures provided by ProAgent 

 Selection of the control whose signals shall be displayed by the HMI 
system 

 Selection of the technological units to be displayed 
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 Generation of the HMI project and loading of the generated data into 
the output device (HMI) 

6.3.3 Functional procedure of the process diagnostics 

Figure 6-8 

 

Error recognition 

The error recognition proceeds via the blocks which are generated by S7-
PDIAG / S7-Graph on an S7 CPU. At the time an error occurs the signal 
statuses of the involved operands are acquired and stored (initial value 
acquisition) so that they can be displayed and analyzed later. The number 
which is assigned to the error is reported to the connected HMI devices 
together with any associated values (e.g. reached temperature). 

Message display 

Both, the coming and going of a process error, is recognized by S7-PDIAG 
/ S7-Graph and displayed as a coming or going message on the output 
device (HMI). There are two options for display on the HMI device: 

 The message is displayed with clear text and date and time in a 
message window. 

 If the user needs more information the involved signals and the gating 
logic can be displayed in the ladder diagram or statement list in a detail 
window. The triggering signals are determined and marked in a criteria 
analysis. 



 
Diagnostics

WinCC – Examples of integrated engineering with STEP 7  Entry ID: 34995306

 

Version V1.0 Issue 27.04.2009 132/230
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 C
o

p
yr

ig
h

t 
20

09
 A

ll 
rig

h
ts

 r
e

se
rv

ed
 

   

Criteria analysis 

In the event of process errors the criteria analysis can be used to detect the 
error-causing operand based on the initial values and with it the cause of 
the process error can be detected with S7-PDIAG / S7-Graph in connection 
with the output devices (with Boolean program logic). 

Error recovery 

The error recovery can be carried out via manual intervention into the 
process and / or via manual control of the process (at the output device). 
Since error recovery usually requires moving of the units in manual mode, 
this is also supported by a standardized motion picture. The switchover 
between manual mode and automatic mode can also be carried out via the 
HMI device. 

6.3.4 Monitoring types 

Operand monitoring 

With operand monitoring you monitor whether the diagnostics entry 
operand (DEO) has a certain level after a certain time (monitoring time). If 
that is the case, the error is signalled as coming. The error is going when 
the operand changes its level again. Depending on the selection of level or 
edge monitoring the delay time will start immediately or after the next active 
edge only. 

Motion monitoring 

In S7-PDIAG you have four predefined monitoring types which are 
specifically provided for motion monitoring in their process. The motion 
monitoring types are preassigned by the logic and all that you have to do is 
completing them. When entering the motion monitoring you utilize a 
predefined monitoring logic which you have to complete and which you can 
change. The error status occurs when the defined conditions are fulfilled. 

General monitoring 

When you use general monitoring you can specify your own monitoring 
logic as a sequence of logic expressions. Use the language elements in 
S7-PDIAG to create a monitoring logic by which a complex error monitoring 
is possible. The error status occurs when the defined conditions are fulfilled 
(logic = TRUE). The diagnostics entry operand only serves as entry for the 
criteria analysis. If this operand is to become part of the monitoring (i.e. 
triggering the error), you have to specify it explicitly. 
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6.3.5 Parameterization of PDiag 

Table 6-12 

Step Action 

1.  Select the CPU and start the process diagnostics dialog via "Options > Configure 
Process Diagnostics". 

2.  Customize the settings via "Options > Customize...". 
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Step Action 

3.  Free message input 
The message text for the error definition can be freely defined. 
Symbol name as message 
The symbolic name of the DEO is taken from the symbol table and used as 
message text. 
Symbol comment as message 
The symbol comment on the DEO is taken from the symbol table and used as 
message text. 
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Step Action 

4.  Activate initial value acquisition 
The initial value acquisition for all error definitions is deactivated. Thus the settings 
for the initial value acquisition at the individual error definitions are ineffective. 
Use auxiliary networks 
The outputs and memory bits are substituted by S7-PDIAG if used in a network as 
far as a setting network is known for these operands. (important for criteria analysis) 
Using outputs 
The outputs are also substituted when the auxiliary networks are created. 
Load diagnostic-relevant network data in the AS 
The diagnostic-relevant network data are directly transferred to the automation 
system in order to reduce the generation times. 
Overwrite instances 
If you have made changes to instances, you can force inheritance through the type 
again during the activation. 
Preset final positions 
The final position names of motions are automatically preset with the symbolic 
names of the operands configured at the block call. 
Update message texts using symbol table 
If you have made changes in the symbol table after configuring the message texts, 
they will be updated in the message texts. 
Record associated values 
The configured associated values are transferred to the message blocks. There are 
8 bytes available in the data block of the corresponding error detection block per 
error definition. 
Display warnings 
Warnings during the generation are displayed. 
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Step Action 

5.  Default settings 
The numbers of the blocks for monitoring and for the initial value acquisition are 
determined.  
Call User Block 
The user block (FB with DB) is called for every coming and going error message in 
the error case. 
Storage Location for Group Priority  
A memory bit word can be assigned per program. The bit "0" corresponds to the 
priority 1, the bit "15" to the priority 16. 
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Step Action 

6.  Configuring error definitions 
Before you can create a monitoring feature you have to select the diagnostics entry 
operand first. There are the following three options for this, depending on whether 
you want to select the DEO in the LAD / STL / FBD editor, in the unit overview of S7-
PDIAG or in the symbol table. 
 
LAD/STL/FBD 

 
 
Unit overview of S7-PDIAG 

 
 
Symbol table 
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Step Action 

7.  Select the monitoring type and add a definition for it then. 

 
 
Example of message text 
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Step Action 

8.  Support of the type/instances concept 
S7-PDIAG supports the type/instances concept of SIMATIC S7. This means that 
error definitions can be entirely configured at the respective block type, i.e. at the 
FB. S7-PDIAG will then automatically create the instances of the error definitions 
including the corresponding different messages analogously to the instance data 
block in your user program.  
 
Error definition types 

 
Instances of the error definition 
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Step Action 

9.  Call Error Detection  
In order that the compiled monitoring blocks will be edited in the process and the 
defined errors will be reported, you have to link them in the cycle; for this purpose 
you should insert the call of the monitoring blocks at the end of OB1. 
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6.3.6 Monitoring with ProAgent in WinCC 

Prerequisites 

 WinCC must have been installed integrated in STEP7 (integrated 
project) 

 The option ProAgent must have been installed 

 Connection between CPU and SCADA 

 Control program with error definitions must have been created and 
compiled 

 Runtime licence for ProAgent 

 

Configuration 

 PC station with WinCC application 

 ProAgent standard pictures are created when the units are generated 

 

Selecting units 

In WinCC you can determine what controls and units you wish to monitor 
with a certain OS. If your plant has several OS it is desirable, of course, to 
perform the diagnostics on every OS only for such units which are actually 
controlled with this OS. The units which are monitored with an OS can be 
located in different STEP 7 projects if they have been combined in a STEP 
7 multi-project. 

When ProAgent was installed, there is a new editor by the name of 
"ProAgent" in WinCC Explorer. It contains the completely configured 
diagnostic screens for the different versions of the WinCC applications. The 
names of the pictures of the process diagnostics all start with the prefix 
"@Diag". 
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Table 6-13 

Step Action 

1.  Mark the editor "ProAgent" and open it via the properties dialog. 
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Step Action 

2.  You can see all selected units in the configuration dialog which are taken into 
consideration during the generation. 

 
3.  Via the "Units" button this list can be edited. 
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6.3.7 Overview of the diagnostic screens 

Figure 6-9 

 

 

Global keyset of the diagnostic screens 

Figure 6-10 

 

1. Overview 

2. Detailed picture 

3. Motion picture 

4. Message display 

5. Sequence chart diagram 

6. Simatic Manager 

7. Status / Control 

8. Change language 

9. Screen information 

10. Back 
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Note The global keyset is available for all diagnostic screens. 

 

Overview 

The overview shows all units of your plant. Here you can see of each unit: 

 whether it is disturbed. 

 in what mode it is (manual, automatic, etc.). 

 in the case of S7-GRAPH chains what step of the step sequence is 
currently active. 

When a fault occurs in several units you can see at what unit the fault 
occurred first. This shows you immediately where the actual cause rests 
and what faults are actually secondary faults. 

 

Functions 

A unit can be selected from the list and its mode can be set. For example, 
you can switch over from automatic mode to manual mode to remove a 
fault manually. After having selected a unit you can analyse it in detail in 
the detail screen and manually move single units in the motion screen to 
remove the fault. If the unit is based on an S7-GRAPH step sequence, you 
can activate or deactivate single steps or the entire sequence in the step 
sequence screen. 
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Figure 6-11 

 

 

Detailed picture 

Displayed error 

What error is displayed when the detail screen is opened depends on the 
location from which you called the detail screen: 

 If you called the detail screen from out of the message screen, you had 
selected a message there. The detail screen shows the error now which 
triggered this message. 

 If you called the detail screen from out of the overview screen, you had 
selected a unit there. The detail screen shows the error of the first faulty 
action of this unit now. 

General setup 

As all diagnostic screens the detail screen has a standardized structure. 
Changing the display between signal list, STL and LAD will only change the 
central part of the detail screen. The information about the unit (in the upper 
part) and the key assignment will remain unchanged. 



 
Diagnostics

WinCC – Examples of integrated engineering with STEP 7  Entry ID: 34995306

 

Version V1.0 Issue 27.04.2009 147/230
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 C
o

p
yr

ig
h

t 
20

09
 A

ll 
rig

h
ts

 r
e

se
rv

ed
 

   

Figure 6-12 
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Alarms screen 

In the alarms screen, all pending process indications are displayed. The 
messages are output in a chronological order on the screen. The alarms 
screen is frequently used as the entry to the diagnostics. Here you can 
monitor whether and what faults occur and then you can access all further 
diagnostic screens. 

 

Additional functions 

The alarms screen is structured quite similar to a common message page. 
However there are some additional information and functions available. 
You can see at a glance from an asterisk in front of the message number 
what messages are diagnosable. You can perform process diagnostics for 
these messages then. You can select a certain message and open other 
diagnostic screens context-sensitively with a button: 

 Detail screen 
There you can see an extract of the program code whose monitoring 
feature triggered the selected fault message. 

 Overview screen 
There you get an overview over the different units of your plant. 
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Figure 6-13 
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Linking the diagnostic screens 

After the diagnostic screens have been linked, you have to give the 
operator access to them. Depending on the type of your project there are 
several options for linking the diagnostic screens: 

 The project exclusively serves for process diagnostics. It only contains 
diagnostic screens and no further plant screens. In that case your 
project should start with the supplied diagnostic start screen in runtime. 

 The project contains further plant-specific screens apart from the 
diagnostic screens. In that case it is advisable to make one of these 
screens your start screen or to create a general start screen. 

 The process diagnostics shall not be started with a start screen but with 
a diagnostic screen (e.g. directly with the detail screen). In that case 
you have to define in your configuration what unit shall be displayed in 
the diagnostic screen. 

Table 6-14 

Linking the diagnostic screens 

Diagnostic start screen is the start screen of the project: 

 
Calling the diagnostic start screen: 

 
Calling any diagnostic screen: 
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6.3.8 Criteria analysis 

Initial value / status acquisition 

If the initial value acquisition is activated for an error definition, all binary 
statuses of the operands will be recorded in the cycle in which an error is 
detected which were used for the creation of the operand (DEO) which is to 
be monitored. In this way you can perform a criteria analysis which will 
make error recovery easier. Analogously these values can be acquired in 
every cycle; they are designated as status values then. 

 

Auxiliary networks 

The auxiliary networks which are created by S7-PDIAG are networks which 
describe the used preceding logic operations. These preceding logic 
operations are used further in a network which is to be analyzed. S7-
PDIAG uses the auxiliary networks for criteria analysis.  

 

Criteria analysis 

The criteria analysis determines the cause of the error from the logic of the 
user program. The criteria analysis is performed on the output device. It 
serves for tracing the error cause. A criteria analysis starts at the 
diagnostics entry operand and analyzes the initial values of all networks 
which determine the value of the diagnostics entry operand. 

The criteria analysis proceeds in two steps: 

 first all RLO values are determined from the initial values for all 
operands of the network in which the error occurred. 

 then the individual lines are checked starting at the network end and 
marked as faulty or not. 
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Figure 6-14 

 

6.3.9 Monitoring types 

Interlock 

is a programmable condition for step locking which has an influence on the 
execution of individual actions 

 fulfilled interlock => no fault 

 not fulfilled interlock => fault 

 "C" - identifier of interlock 

 

Figure 6-15 
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Supervision 

is a programmable condition for step supervision which has an effect on the 
switchover from one step to the next 

 not fulfilled supervision => no fault 

 fulfilled supervision => fault 

 "V" - identifier of supervision 

 

Figure 6-16 
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6.3.10 Configuring error definitions 

Table 6-15 

Step Action 

1.  Define a monitoring type. 
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Step Action 

2.  Activate the message channel. 

 
3.  Check the predefined message texts with step number and step name. 



 
Diagnostics

WinCC – Examples of integrated engineering with STEP 7  Entry ID: 34995306

 

Version V1.0 Issue 27.04.2009 156/230
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 C
o

p
yr

ig
h

t 
20

09
 A

ll 
rig

h
ts

 r
e

se
rv

ed
 

   

6.3.11 Step sequence screen in WinCC / ProAgent 

The step sequence screen is structured as follows: 
The step list shows the following information about the unit which was 
selected in the diagnostic screen from which you called the step sequence 
screen: 

 Designation 

 Current step with number and name 

The list of faulty operands in the lower left part of the screen displays 
information about the operands of the selected step. 
The step diagram in the right part of the screen graphically shows the 
steps. 

Functions 

The step sequence screen allows you to manually select single steps to 
activate or deactivate them, to re-initialize or disable the step sequence. 

Figure 6-17 
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6.4 Further reading 

Bibliographic references 

This list is not complete and only represents a selection of relevant 
literature. 

Table 6-16 

 Topic Title 

/1/ STEP7 V5.4 Documentation 
Basic Knowledge 

6ES7810-4CA08-8AW0 

/2/ Documentation of WinCC 
V7.0 

http://support.automation.siemens.com/W
W/view/en/29489481 

/3/ Programming S7-GRAPH 
V5.3 for S7-300/400 
sequential controls 

http://support.automation.siemens.com/W
W/view/en/1137630 

Internet links 

This list is not complete and only represents a selection of relevant 
literature. 

Table 6-17 

 Topic Title 

\1\ Report S7-system error in 
connection with FB125, 
FB126 and SFC13 

http://support.automation.siemens.com/W
W/view/en/17858394 

\2\ Programming S7 diagnostic 
blocks FB125 and FC125 

http://support.automation.siemens.com/W
W/view/de/387257 

\3\ Diagnostic package 
PNIODiag 

http://support.automation.siemens.com/W
W/view/de/26996747 

\4\ Report S7-System Error http://support.automation.siemens.com/W
W/view/en/22727527 

\5\ Display of old S7-PDIAG 
messages 

http://support.automation.siemens.com/W
W/view/en/10604215 

\6\ Criteria analysis beyond 
block boundary 

http://support.automation.siemens.com/W
W/view/en/27540030 

\7\ Using the Web Diagnose 
Client/Server 

http://support.automation.siemens.com/W
W/view/en/22619825 

 

 

 

https://support.automation.siemens.com/WW/llisapi.dll?query=6ES7810-4CA08-8AW0&func=cslib.cssearch&content=skm%2Fmain.asp&lang=de&siteid=csius&objaction=cssearch&searchinprim=&nodeid99=�
http://support.automation.siemens.com/WW/view/en/29489481�
http://support.automation.siemens.com/WW/view/en/29489481�
http://support.automation.siemens.com/WW/view/en/1137630�
http://support.automation.siemens.com/WW/view/en/1137630�
http://support.automation.siemens.com/WW/view/en/17858394�
http://support.automation.siemens.com/WW/view/en/17858394�
http://support.automation.siemens.com/WW/view/en/387257�
http://support.automation.siemens.com/WW/view/en/387257�
http://support.automation.siemens.com/WW/view/en/26996747�
http://support.automation.siemens.com/WW/view/en/26996747�
http://support.automation.siemens.com/WW/view/en/22727527�
http://support.automation.siemens.com/WW/view/en/22727527�
http://support.automation.siemens.com/WW/view/en/10604215�
http://support.automation.siemens.com/WW/view/en/10604215�
http://support.automation.siemens.com/WW/view/en/27540030�
http://support.automation.siemens.com/WW/view/en/27540030�
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7 Basic Process Control 

7.1 Introduction 

Basic Process Control (BPC) is included in the WinCC basic system as a 
standard and it provides additional tools for configuration to realize typical 
control tasks. 

Area of application 

With BPC you can use quite a number of control functions from the process 
control system for your configuration. The control system is created 
automatically and supports you in the efficient configuration. 

Overview of Basic Process Control 

The following figure shows a selection of components of the Basic Process 
Control: 

Figure 7-1 
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7.2 Prerequisites 

Basic Process Control is a WinCC option and is only available if the option 
"Basic Process Control" has been selected during the installation. 

Figure 7-2 

 

 

Note From WinCC V6.0 BPC has been part of the software package and need 
not be licensed separately. 
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View in the WinCC Explorer 

Figure 7-3 
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7.3 Time synchronization 

The time synchronization is a WinCC application which is used to 
synchronize the time of the whole system according to the SIMATIC 
procedure. 

The time synchronization is configured with the "Time Synchronization" 
editor. The time can be synchronized as follows: 

 via the local area network / terminal bus for the Operator Station. 

 via the plant bus/Industrial Ethernet bus for WinCC Server with 
connection to the automation systems. 

7.3.1 SIMATIC procedure 

 The SIMATIC procedure is based on the communication of two 
communication processors (CP). 

 The communication of the respective CPU with the CP takes place on 
the backplane bus. 

 The SIMATIC procedure is a combination of different time 
synchronization methods, depending on the used bus. 

 Depending on the bus on which the time is stored an automatic runtime 
adaptation of the message is carried out. 

 

Figure 7-4 
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7.3.2 Master/slave principle 

A computer or a specialized device, e.g. Siclock, serves as time master. 
This master transmits the time to all other devices, the slaves. Only one 
master can be active in the network and it usually has an external time 
signal receiver. 

The slaves can use two different procedures to synchronize the time with 
the master: 

 One master is active and sends the time messages to the bus. The 
slaves receive these time messages and synchronize their time then. 
Several devices may be configured as master if they support the 
standby mode. The masters in standby-mode are slaves as long as the 
active master is sending time telegrams. When a standby master 
detects the absence of the time messages, one of the standby masters 
will take over the function of the active master and start sending time 
messages. The devices which communicate via the plant bus use this 
"master broadcast" procedure. 

 The slaves are active and poll the master periodically for the time which 
is to be synchronized. Each slave has to specify which device is the 
master. If a master fails, the slaves cannot assume the function of the 
master. Therefore the slaves need a list of the masters which can 
substitute the failed master. Computers in the local area network use 
this "polling" procedure. 
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7.3.3 Time synchronization in runtime 

The time synchronization is entered in the startup list of the computer when 
the following events occur and it is activated at the start of WinCC runtime: 

 at the run of the OS project editor. 

 after the configuration in the "Time Synchronization" editor. 

After the run of the OS project editor you have to configure the time 
synchronization. 

After the start of runtime the time synchronization is activated after 
maximally three minutes. 

7.3.4 Preventing time jumps 

Time jumps at the master will not be sent to the system. In order to prevent 
this, WinCC proceeds as follows: 

 When the time is synchronized via the terminal bus or an access point 
in the plant bus is configured as master and another access point is 
configured as slave, the time synchronization is permanently 
deactivated. A corresponding control system message is sent. 

 When the time is synchronized via the plant bus and the access points 
in the plant bus are configured as master, the access points will be set 
to the slave mode. The master of another computer assumes the time 
synchronization and synchronizes the time of the respective computer. 
A corresponding control system message is sent. 

Note "Greenwich Mean Time" (GMT) or winter time is used for the user data 
and time messages in all devices of the plant bus. WinCC V5 projects 
allowed upgrading to WinCC V6 only when the option "V5-compatibel 
communication mode" was ticked in the dialog field "Properties 
Computer" on the tab "Parameter" in the WinCC Explorer. The following 
default setting is activated for this option: 

 for newly created projects from WinCC V6: option deactivated. 

 for projects migrated from WinCC V5: option activated. 
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7.3.5 Hardware support of the time synchronization 

Industrial Ethernet with automation systems 

The time synchronization must have access to the Industrial Ethernet bus 
with which the AS communicates. Special hardware cards provide the 
capability for transmitting and receiving time messages. 

The following Industrial Ethernet devices support the time synchronization: 

 CP1613 hardware card - The software is integrated in the card. 

 SoftNet/BCE hardware / software solution - A software driver emulates 
the hardware. 

The two cards have the following properties: 

 They have an internal clock. 

 They can operate as slaves. They recognize if time messages are not 
received. 

 They can operate as active or standby master. 

 The synchronization interval is set to 10 seconds and cannot be 
configured. 

Local area network with operator station 

The operator station synchronizes its local time via the local area network. 
All network adapters which support Windows can be used. 
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Parameterization levels: 

Figure 7-5 
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7.3.6 Configuration in WinCC 

The time synchronization via terminal bus 

The time synchronization via local area network / terminal bus is possible in 
three ways: 

 The computer is automatically synchronized via a linked WinCC server. 

 The time is transferred from one of the permanently defined computers 
in the network. 

 The time is set via a 3rd-party component. 

The time synchronization via plant bus/BCE 

You can use a BCE network card to synchronize the time via the plant bus. 

Note If the computer which is to be configured is a WinCC client, the selection 
fields of the time synchronization cannot be controlled via the plant bus. 

 

Open the "Time Synchronization" editor with a double-click in the WinCC 
Explorer. Make the required settings in the dialog field for the configuration. 

Figure 7-6 
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7.3.7 Configuration in STEP 7 

Only after the configuration of the CP has been made it will be capable of 
processing the time messages. 

Figure 7-7 
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You can set the time synchronization in HW-Config under the properties of 
S7-CPU.   

Time interval 10 seconds (typical setting) 

If you parameterize the CPU clock as master (clock) for MPI and set the 
time interval for synchronization to 10 seconds, the CPU will transmit a time 
synchronization message via the MPI interface at the following times: 0 s, 
10 s, 20 s, ..50 s . 

Time interval 24 hours 

The time synchronization message is transmitted at midnight. 

Figure 7-8 

 

 

You can set the synchronization separately: 

 in the AS (i.e. internally) 

 on MPI (i.e. externally) 

 on MFI (i.e. externally via 2nd interface) 

You can set the following parameters: 
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Synchronization type 

You can determine whether the clock synchronizes other clocks (setting 
options depend on CPU). 

 as slave: The clock is synchronized by another clock.  

 as master:  The clock synchronizes other clocks as master. 

 None:  There will be no synchronization. 

Time interval 

Select at what time intervals the synchronization shall take place. 

Correction factor 

The correction factor is used to compensate a deviation of the clock within 
24 hours. You can enter positive or negative values in ms. 

Example: 
If the clock is slow by 4 seconds after 24 hours, enter a correction factor of 
"+4000 ms". 

Figure 7-9 
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Figure 7-10 

 



 
Basic Process Control

WinCC – Examples of integrated engineering with STEP 7  Entry ID: 34995306

 

Version V1.0 Issue 27.04.2009 171/230
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 C
o

p
yr

ig
h

t 
20

09
 A

ll 
rig

h
ts

 r
e

se
rv

ed
 

   

7.3.8 Example configuration 

The time synchronization is explained by means of an example now. The 
following is assumed: 

 The S7-400 station is the time master. 

 The S7-300 and CP 1613 are synchronized via the S7-400. 

 The CP 1613 assumes the role of a cooperative master. 

 The WinCC Server functions as time master within the terminal bus. 

 Both WinCC Clients are synchronized via the WinCC Server. 

 

Figure 7-11 
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The S7-400 station as the time master. 

 

Figure 7-12 

 

 

Figure 7-13 
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The S7-300 station as the time slave. 

 

Figure 7-14 

 

 

Figure 7-15 
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The WinCC Server as cooperative time master (standby) 

 

Figure 7-16 
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The WinCC Clients as time slaves 

 

Figure 7-17 
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7.3.9 The "Time Synchronization" editor 

Open the "Time Synchronization" editor with a double-click in the WinCC 
Explorer. Make the required settings in the dialog field for the configuration. 

 

Figure 7-18 
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Use time receive utility 

When you activate the option "Use time receive utility" the time receive 
utility is active. When used at the plant bus the time synchronization checks 
now whether the time receive utility is deactivated during the slave 
operation and activated during the master operation. 

Deactivate the time receive utility during the slave operation to prevent that 
the computer time is set by the time synchronization and by the time 
receive utility. 

Deactivate time synchronization 

When you activate the option "Deactivate time synchronization" the time 
synchronization is deactivated. The time messages are not sent now and/or 
the local time is not set. The time synchronization is only deactivated after 
the option has been ticked and acknowledged by clicking the "OK" button. 

After every activation/deactivation of the time synchronization you get a 
corresponding operator message in runtime. 

Settings for synchronization 

Synchronization is configured via the plant bus / Industrial Ethernet bus or 
via the local area network. Activate the respective options for this. You can 
also use both options in parallel. 

Synchronization via terminal bus 

The time synchronization via terminal bus / local area network is available 
on WinCC Server projects and WinCC Clients. There are three options for 
configuration: 

 The time of the computer is automatically transferred from a linked 
WinCC Server. The server packages must have been loaded for this 
purpose. 

 The time is transferred from one of the computers in the network which 
you entered in the input fields "Computer 1" and "Computer 2". 

 The time is set via an external 3rd-party component. 
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Synchronization via plant bus 

The time synchronization via the plant bus / Industrial Ethernet bus is only 
available on WinCC Server projects. If the computer which is to be 
configured is a client the selection fields are not operator-accessible. 

You can use a BCE network card or up to two CP1613 for the time 
synchronization. 

The selection list of "Access point 1" and/or "Access point 2" displays all 
devices or network cards which are installed on the computer which are 
suitable for time synchronization via the Industrial Ethernet bus. Select from 
the dropdown list the device which you can configure either as master or as 
slave. Tick the respective option to determine the role of the device. 

To configure the time synchronization from an ES, you can also have 
symbolic names of the access points displayed which are given between "< 
>". 

Activate the respective option for this. When the target PC is started up in 
runtime these names will be assigned to the physical names of the access 
points. 

Settings for process controlling messages 

When problems occur in the synchronization, process controlling messages 
will be displayed in runtime. For the periodically recurring process 
controlling messages 1012002-1012005, 1012018, 1012021 and 1012028 
you can determine in the field "Process controlling messages" how often 
these process controlling messages will be displayed in runtime. 

To display the process controlling message only once, tick the option "Send 
once". 

If the process controlling message is to be sent several times in runtime, 
untick the option "Send once". Enter the desired value directly in the input 
field "Send every ... minutes" or use the up or down arrow buttons. 



 
Basic Process Control

WinCC – Examples of integrated engineering with STEP 7  Entry ID: 34995306

 

Version V1.0 Issue 27.04.2009 179/230
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 C
o

p
yr

ig
h

t 
20

09
 A

ll 
rig

h
ts

 r
e

se
rv

ed
 

   

7.3.10 Time zones 

UTC is used on the AS since time jumps as in the clock change are not 
permitted on the AS. Depending on the configuration, time jumps might 
result in that the time-of-day interrupts, for instance, are not executed 
correctly anymore or the operating hour counters do not count correctly 
anymore. 

Therefore, use Universal Time Coordinated (UTC) as a rule. It is 
characterized as follows: 

 UTC is the international time basis which is determined by atomic 
clocks. 

 UTC does not use daylight-saving time and winter time. 

 UTC refers to the Prime Meridian through Greenwich near London. 

UTC corresponds to GMT (Greenwich Mean Time) with clocks not moved 
forward for daylight-saving time. The local time zone is set in the control 
panel of your computer under "Date and Time Properties". 

There are two GMTs: 

 GMT with clock set to daylight-saving time (Dublin, Edinburgh, Lisbon, 
London)  

 GMT with clock not set to daylight-saving time, i.e. corresponding to 
UTC (Casablanca, Monrovia) 
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Figure 7-19 
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Settings in WinCC 

In WinCC the time settings can be made in the computer properties. 

Figure 7-20 
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7.4 Horn 
The horn is used to control visual or acoustic alarm devices. It outputs 
sound files when messages are received. With the "Horn" editor you 
configure what signals are to be triggered upon what messages. 

7.4.1 Principle of operation 

A coming message activates a signal tag which triggers an acoustic or 
visual signal at the assigned alarm device. By acknowledging the message 
the signal tag is reset and the signal is terminated. 

7.4.2 Overview of horn function 

The following figure schematically shows the structure of the horn-function 
in WinCC. 

Figure 7-21 
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7.4.3 Message assignment 

Open the "Horn" editor by double-clicking the entry horn or with the menu 
option "Open" in the WinCC Explorer context menu. 
In the first tab "Message assignment" you assign certain properties of 
messages to signal tags. The following message properties serve as a filter 
to trigger a signal: 

 Message class 

 Priority 

 Source 

 Area 

 Event 

In the column "Authorization" you determine in addition whether the horn is 
triggered user-specifically upon messages from certain areas when the 
specified filter criteria are fulfilled. 

Every line forms a logic "AND" with six inputs. Only if all six conditions are 
fulfilled, the respective signal tag will be set to "1". 

Figure 7-22 
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7.4.4 Signal assignment 

In the second tab "Signal assignment" you configure the signals for the 
incoming messages. You assign existing physical signal modules to the 
signal tags and specify the acknowledgement response. 

Print the configuration data of the horn with the "Project documentation" 
button. 

Figure 7-23 
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7.5 OS project editor 

The OS project editor is used for configuring the runtime surface and the 
alarm system. The project editor provides extended options for the 
customization of basic data. Use the OS project editor to place the keys in 
the overview area and configure the sequence of the areas. 

7.5.1 Principle of operation 

When you create a project in WinCC you start the OS project editor in 
WinCC Explorer. The OS project editor must be executed before the User 
Administrator is opened as otherwise the latter will be initialized with the 
authorization levels of WinCC. 

When the OS project editor is opened for the first time the default settings 
will be displayed. A suitable layout is selected for the runtime-surface by 
means of the screen resolution and the project type. If a suitable layout is 
not found, the OS project editor will select the first layout from the list of 
available layouts in the tab "Layout". 

When you open the OS project editor again, the current project settings will 
be displayed. Changed basic data image files and actions have to be 
acknowledged in the tab "Basic data" first before these data will be applied 
in the project. 
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7.5.2 Layout 

Settings for the runtime-surface layout are made in the tab "Layout". The 
basic data are organized in the layouts. A layout is defined in a 
configuration file. 

Monitor configuration 

In the group "Monitor configuration" you determine the desired screen 
layout of the target device in runtime. You can select only the supported 
monitor configurations for the selected layout. Prior to the execution of the 
OS project editor settings have to be made for the multi-VGA in the control 
panel of the operating system. 

Overview extended configuration 

When the layout supports the generic arrangement of the layout keys in the 
overview area, the "Detail" button will be enabled at "Overview extended 
configuration". 

The output fields "Number of area keys" and "Number of server keys" show 
the currently configured number of keys. If the layout does not support 
these functions, the fields remain blank and the "Detail" button is not 
operator-accessible. 

The "Detail" button opens a dialog field for configuration of the overview 
area. The number of keys is configured in this dialog field. 
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Figure 7-24 

 

 

Figure 7-25 

 



 
Basic Process Control

WinCC – Examples of integrated engineering with STEP 7  Entry ID: 34995306

 

Version V1.0 Issue 27.04.2009 188/230
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 C
o

p
yr

ig
h

t 
20

09
 A

ll 
rig

h
ts

 r
e

se
rv

ed
 

   

7.5.3 Message configuration 

The OS project editor outputs the following data from the message system 
when the tab "Message configuration" is opened for the first time: 

 Message classes 

 Message types 

 System messages 

In the tab "Message configuration" you determine the configuration of the 
message system performed by the OS project editor. 

Figure 7-26 
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7.5.4 Message display 

In the tab "Message display" you configure the runtime behaviour of the 
message system and the display of the messages on the message pages 
or in group displays. 

Figure 7-27 
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7.5.5 Area 

In the tab "Area" you configure the arrangement of the area and server 
keys for the overview area. Here you also determine user access to areas 
for which authorization is not available. 

The area keys result from the plant areas which you configured in the 
Picture Tree Manager and they contain the following: 

 one key for opening the area. 

 a group display for displaying the group value of this area. 

 one key for opening the Picture Tree Navigator. 

The server keys serve for visualization of a server in the overview area and 
they contain the following: 

 one key for server selection. 

 a group display for displaying the group value of this server. 

Figure 7-28 
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7.5.6 Runtime window 

In the tab "Runtime window" you configure the settings for the number and 
arrangement of the pre-configured picture windows. 

Figure 7-29 
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7.5.7 Basic data 

The basic data contain image files, actions and standard functions to 
provide a corresponding surface in runtime. The tab "Basic data" shows 
which initialized basic data deviate from the local basic data of the project. 

The picture settings depend on the respective layout. The list entries 
change depending on the picture and script configuration. 

You can set in this tab what changed files of the project will be overwritten 
by files of the delivered state. However the consistent runtime operation 
must be ensured. The red list entries must be overwritten. The option box 
cannot be deactivated. 

Figure 7-30 
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7.5.8 General information 

The tab "General" contains settings for the OS project editor. 

Figure 7-31 
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7.6 Group display 

Group displays provide a condensed display of process statuses (statuses 
of messages) in a graphical form. There are 16 different message types. 

The group display object is accessed with a tag which represents the 
message status. This tag can be used in the other WinCC components if 
you want to show group display statuses there. 

The group display object is visualized in the area overview, in the Picture 
Tree Navigator, in the faceplate and in the process image by configured 
group displays. 

The group displays in the area overview and in the Picture Tree Navigator 
always refer to the plant area (picture hierarchy) only in which they are 
displayed. 

Note Note the following when using group displays: 

 The group displays in the area overview are derived through a logic OR from 
the sum of all group displays which are located in subordinated pictures 
which belong to this area. 

 "Alarm", "Warning" and process controlling messages require 
acknowledging. 

 

Hierarchy of the group displays 

The group display usually consists of several individual displays which have 
occurred in an area or sub-area. This creates a kind of hierarchy of group 
displays. When you select the alarm source, the picture on the lowest level 
will be displayed as a rule in which assignment to a certain alarm is still 
possible. 

The OS project editor supports you in configuring the group display 
hierarchy. When you activate the option "Create/update group displays" in 
the tab "Message display", the group displays in the area overview will 
automatically be placed in the picture hierarchy. You can also interconnect 
the group display objects independently of the picture hierarchy. 

 

For further information about the configuration of a group display refer to 
the following entry: 

http://support.automation.siemens.com/WW/view/en/17778440 

http://support.automation.siemens.com/WW/view/en/17778440�
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7.7 Picture Tree Manager 

The Picture Tree Manager serves for the management of a hierarchy of 
systems, subsystems, function names and Graphic Designer pictures and it 
provides the following functions: 

 Creating and changing a project hierarchy 

 Support in the definition of systems and subsystems 

 Support in the assignment of pictures to these systems. It creates an 
order between the pictures made in Graphics Designer. 

 Support of the picture selection in runtime through navigation in the 
hierarchy tree. 

7.7.1 Configuration procedure 

Start the Picture Tree Manager with a double-click in the WinCC Explorer. 
The editor has only one window for editing the hierarchy.  

The following functionalities are available here: 

 By means of the buffer and the functions "Cut", "Copy", "Paste" you 
create and edit the hierarchy. 

 The editing functions are accessed via the menu bar, the context menu 
or via drag&drop. 

 By inserting the empty container from the selection window you extend 
the hierarchy by one container. 

 By cutting and pasting a picture from the selection window or by 
drag&drop you add a picture in a container of the hierarchy. 

 You can also shift subhierarchies (subtrees) within the hierarchy. 

 Pictures which you remove from the hierarchy (hierarchy window) are 
automatically added in the selection window. 

 Picture properties such as change date and size of a selected picture 
can be displayed. 
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7.7.2 General information on hierarchy 

In WinCC the interdependency of containers and pictures is mapped in the 
form of a hierarchy. Please note the following for this hierarchy: 

 The nodes of the hierarchy are containers as a rule. 

 Every container can be empty or contain a picture of the Graphics 
Designer. 

 You can assign any name to the containers. However the container 
names are assumed to be unique which will be verified by the Picture 
Tree Manager. If you derive the picture hierarchy from the plant 
hierarchy the entire path with separators will be entered for the 
container names. However only the last part of the container name will 
be displayed in runtime. 

 You can only insert existing pictures in the hierarchy. Picture names 
cannot be changed in the Picture Tree Manager. 

 The hierarchy structure is open, i.e. there is no restriction with regard to 
the depth and width of the hierarchy (tree). 

 When you create a hierarchy with the Picture Tree Manager, hierarchy 
information will be stored in various WinCC-engineering data, e.g. in the 
message system, in the User Administrator and in block lists. Therefore 
it is necessary to determine the WinCC-hierarchy at an early stage in 
the configuration process and to maintain it. 

 Subsequent changes of a hierarchy on an area level necessitate 
manual corrections at the following points: 

– Correction of hierarchy data in the messages 

– Updating of user authorizations (User Administrator) 

– Creating new packages for connected WinCC Clients 
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7.7.3 Recalculation of the group display hierarchy upon saving 

If the option "Calculate the group display hierarchy completely new again 
while saving" is ticked, the group display hierarchy will be recalculated for 
all WinCC pictures upon every saving action in the Picture Tree Manager. If 
no group displays are used, this setting can be disabled to permit faster 
saving. 

When WinCC recognizes during the startup that the group display hierarchy 
is no longer current, the process controlling message "The group display 
hierarchy is not updated..." will be displayed. By saving the picture 
hierarchy with ticked option "Calculate the group display hierarchy 
completely new again while saving" the data can be updated. 

 

Figure 7-32 
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7.8 Lifebeat Monitoring 

The "Lifebeat Monitoring" editor serves for monitoring all server and client 
computers and automation devices which are accessible via PC and 
industrial-networks. 

7.8.1 Principle of operation 

The lifebeat monitoring can only be configured via Industrial Ethernet and 
PROFIBUS connections of the "SIMATIC S7 PROTOCOL SUITE" or via an 
OPC connection between WinCC stations.  

Lifebeat Monitoring monitors servers, clients and automation devices. 
Lifebeat Monitoring usually runs on a central WinCC Client. It provides a 
view on the lifebeat objects which belong to a project and on automation 
devices and operator stations of other projects. For this purpose all system 
parts must be connected to one common network. 

7.8.2 Overview of the process diagnostics 

The following figure schematically shows the structure of the lifebeat 
monitoring: 

Figure 7-33 
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7.8.3 Monitoring of WinCC Stations 

The OPC coupling has to be used for the monitoring of WinCC stations. 
The monitoring via the OPC connection is limited to WinCC stations. 

As the software for the OPC-DA Server and the OPD-DA Client are 
contained in the basic system of WinCC, WinCC can be used 
simultaneously as OPC-DA Server and as OPC-DA client. As a WinCC 
Client the computer can connect to several servers at the same time. 

 

Note Please note the following for the configuration of the lifebeat monitoring in 
a distributed system or a distributed redundant system: 

 The lifebeat monitoring of a pair of servers monitors its subordinated 
automation devices. 

 Configure the monitoring of all WinCC Clients in the network either only from 
the standard pair of servers or distribute the monitoring of the WinCC Clients 
to several pairs of servers. 

 

Figure 7-34 
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7.8.4 Configuration procedure 

Table 7-1 

Step Action 

1.  Start WinCC and add a new driver "OPC.CHN" in the tag management. 

 
2.  Mark "OPC Unit #1". Open the context menu. Select the menu option "New Driver 

Connection". 
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Step Action 

3.  In the context menu of the newly created connection select the menu option 
"Properties". Click the "Properties" button in the tab "General". 
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Step Action 

4.  Enter the name "OPCServer.WinCC" in the input field "OPC Server Name". 

 
5.  Enter the name of the computer which is to be monitored in the input field "Start the 

server on this computer". 

6.  Click the "Test Server" button to check whether the desired OPC connection can be 
established. 

 

Note Please note that correctly set and properly functioning OPC connections 
are a prerequisite for the monitoring of PC stations (WinCC Station). 
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7.9 Further reading 

Internet links 

This list is not complete and only represents a selection of relevant 
literature. 

Table 7-2 

 Topic Title 

\1\ Time synchronization with 
DCF77 

http://support.automation.siemens.com/W
W/view/en/16533276 

\2\ Why is UTC time used on 
the AS? 

http://support.automation.siemens.com/W
W/view/en/23067556 

\3\ Time synchronization via 
the SIMATIC procedure  

http://support.automation.siemens.com/W
W/view/en/18130164 

\4\ Settings for time 
synchronization 

http://support.automation.siemens.com/W
W/view/en/16622902 

\5\ How is the horn configured 
in SIMATIC PCS 7 / 
WinCC? 

http://support.automation.siemens.com/W
W/view/en/17778088 

\6\ Triggering the horn http://support.automation.siemens.com/W
W/view/en/24770643 

\7\ Using a monitor with a 
1680x1050 pixel resolution 
with the OS project editor 

http://support.automation.siemens.com/W
W/view/en/32591055 

\8\ Copying user-specific 
pictures into the currently 
opened OS project with 
the OS project editor 

http://support.automation.siemens.com/W
W/view/en/19688107 

\9\ Configuring a group 
display 

http://support.automation.siemens.com/W
W/view/en/17778440 

\10\ Specifying the folder order 
in the Plant Hierarchy 

http://support.automation.siemens.com/W
W/view/de/19151848 

\11\ Configuring Lifebeat 
Monitoring 

http://support.automation.siemens.com/W
W/view/en/9918678 
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8 Curves 

8.1 Introduction 

The smallest archiving cycle in WinCC TagLogging is 500 ms. There is no 
way to reduce this archiving cycle through settings in WinCC Tag Logging. 

Shorter archiving cycles can be achieved with the process-controlled 
archiving. 

In an S7-400 CPU you can use the block "AR_SEND" (SFB37) for process-
controlled archiving in WinCC. 

 With this method the archive data are collected in the control and then 
transferred to WinCC as raw data. 

 A conversion DLL on the WinCC side interprets the transmitted data 
and enters them in the WinCC archives. 

 For this purpose the AR_SEND block must be suitably interconnected 
in the control. 

 Only parameterization is required in WinCC but no programming.  
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Overview of the message processing 

The following figure schematically shows the structure for process-
controlled archiving in WinCC: 

Figure 8-1 

 

8.2 Principle of operation 

With SFB37 (AR_SEND) one or several process values can be transferred 
in a process controlled mode to archives of the WinCC Tag Logging. For 
this purpose the process values are collected with the respective time 
stamps in a corresponding data area and transferred to the AR_SEND 
block. When a user-specified event occurs, the AR_SEND block sends the 
archive data to WinCC in one or several data blocks. The received raw data 
are entered in the respective archives by WinCC. WinCC uses the 
conversion DLL "nrms7pmc.nll" for the interpretation of the raw data. In 
order that the archive data are correctly interpreted by the functions of the 
conversion DLL, the data have to be processed according to the data 
format required by the conversion DLL prior to sending. 
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8.3 Configuring the process-controlled archiving in WinCC 

Table 8-1 

Step Action 

1.  Configure a connection for communication with the S7 control in the WinCC tag 
management in a channel unit (e.g. MPI or Industrial Ethernet) of the SIMATIC S7 
Protocol Suite. 
Create a tag of the data type "Raw Data Type" in the S7 connection which is used 
for data transmission. The name must not be longer than 24 characters as this name 
can be part of the archive tag name. 

 
2.  With the "Select" button the dialog "Address properties" is opened. In the dialog 

"Address properties" of the raw data tags select the field "Archive Data Link" in the 
area "Raw Data". 
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Step Action 

3.  Open the TagLogging. Create a process-controlled archive tag in a process value 
archive. Use the context menu "New process-controlled tag..." for this purpose. 
Open a selection dialog with the "Select" button to select the raw data tag which is to 
be used for the parameterizing of the archive tag. You can assign a name in the field 
"Archive tag name" which deviates from the internal archive tag name. 
"nrms7pmc.nll" must be selected in the field "Conversion DLL". This value is the 
default setting. 

 
4.  The respective AR_ID and, if required, AR_ID subnumber must be assigned with the 

"Options" button in the area "Conversion DLL". 
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8.4 Configuring the process-controlled archiving in STEP 7 

Table 8-2 

Step Action 

1.  Create a data structure for the data to be transferred (DB or UDT). 

2.  Declare an input variable “AR_ID” as DWORD and set the attributes “S7_a_type“ 
=ar_send, „S7_server“ =alarm_archiv. 
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Step Action 

3.  Invoke the block "AR_SEND" and configure the parameters. 

 
4.  Integrate the FB in your program. 
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8.5 Structure and parameters of a data block 

Table 8-3 

Header type 

Year Month 

Day Hours 

Minutes Seconds 

1/10 s 1/100 s 1/1000 s Weekday 

Cycle 

Unit (type) Unit (area) 

AR_ID-Subnumber 

Data type of the process data 

Number of process values 

Process value 1 

Process value 2 

Process value i 

 

Description of the parameters 

 Header type 

The header type determines the type of the information contained in the 
header: 

– 0: Header without time stamp, header without AR_ID-Subnumber 

– 1: Header with time stamp, header without AR_ID-Subnumber 

– 8: Header without time stamp, header with AR_ID-Subnumber 

– 9: Header with time stamp, header with AR_ID-Subnumber 

Note With the header types 0 and 8 the bytes for the time stamp are dropped 
in the header. As these bytes will not stay reserved in the data block, the 
header is shortened accordingly by 8 bytes.   

 

 Time stamp 

The time stamp contains date and time in the SIMATIC-S7-BCD format. 
The specification of the weekday is not evaluated by WinCC. 
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Note The automation system S7 does not know the switchover of daylight-
saving time / winter time. The local winter time must be set as the system 
time in the AS as a rule. The correction of the time stamp to daylight-
saving time or winter time is done by the conversion DLL in WinCC. The 
corrected time and a daylight-saving time / winter time identification will 
then be available for the WinCC-applications. The corrected time and the 
identification is transferred to the archive in Tag Logging, for instance. 

 

 Cycle 

Cycle in which the process values are read. This parameter is a factor of 
the time units given under unit (area). Data length: Double word. 

Example: 
"Cycle" = 10 ; "Unit(area)" = 4 means: Reading cycle of the process values 
= 10 seconds 

 Unit (type) 

Determines the type of time information and has an influence on the 
parameter "Number of process values": 

– 1: The process values are read out equidistantly. 

– 2:  Every process value has a time stamp. 

– 3: Every process value has a relative time difference in time units 
with a data length of 2 words. 

– 4: Every process value contains the AR_ID-Subnumber. 

 Unit (area) 

Specifies the size of the time units used with unit (type) = 1 or 3: 

– 1: Reserved 

– 2: Reserved 

– 3: Milliseconds 

– 4: Seconds 

– 5: Minutes 

– 6: Hours 

– 7: Days 
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 Data type of the process data 

The process values are stored directly in the S7 format: 

– 0: BYTE 

– 1: WORD 

– 2: INT 

– 3: DWORD 

– 4: DINT 

– 5: REAL 

 Number of process values 

Depending on the entry made in "Unit(type)" a certain number of process 
values can be contained in the transferred data area. The number is limited 
by the maximum length of the 16 Kbyte data area to be transferred. 

Note The following restriction exists for this parameter "Number of process 
values" in the case of the AR_SEND-variant "Multiple archive tags": 

The data blocks for the different archive tags must start at word 
boundaries as a rule. Therefore, an even number of process values 
(=bytes) must be specified for this parameter "Number of process values" 
when the combination of "Data Type Process Values" = 0 (BYTE) and 
"Unit (type)" = 1 (process values with equidistant time intervals) is used. 
This restriction only applies to this AR_SEND variant and this 
combination of data type and "Unit(type)".   

 

8.6 Further reading 

This list is not complete and only represents a selection of relevant 
literature. 

Table 8-4 

 Topic Title 

\1\ WinCC Tag Logging: 
Archiving cycles of 
less than 500 ms 

http://support.automation.siemens.com/WW/view/
de/24048478 

\2\ Using SFB37 
(AR_SEND) 

http://support.automation.siemens.com/WW/view/
de/23629327 

\3\ Process-controlled 
archiving in WinCC 

http://support.automation.siemens.com/WW/view/
de/23629424 

\4\ Process-controlled 
archiving in WinCC 

http://support.automation.siemens.com/WW/view/
de/29488253 

\5\ Siemens I IA/DT 
Customer Support 

http://support.automation.siemens.com 
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9 User archives 

9.1 Introduction 

Data from engineering processes can be stored continuously on a server 
PC with the "User Archive" editor of WinCC. In the Graphics Designer a 
WinCC UserArchiveControl can be configured which permits displaying the 
online data from the user archives in tables during runtime. 

User archives are also used to provide data for automation systems such 
as S5, S7. If required, data can be input in the form of recipes or setpoints 
from the controls. 

The User Archive editor offers two types of database tables: 

 User archives:  
User archives are database tables in which the user can create user-
specific data fields. User archives serve for storing data and they permit 
a standardized access to these data in compliance with the SQL 
database conventions. 

 Views:  
Views get data from the user archives and serve for providing 
overviews 
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Overview of the user archives 

The following figure schematically shows the structure of the user archives 
in WinCC: 

Figure 9-1 

 

9.2 Principle of operation 

When configuring user archives you can create user-specific database 
tables with the "User Archive" editor or with the functions of the WinCC 
script language. 

The "User Archive" editor also permits creating new data records and 
editing data in existing data records even during the configuration. 

In runtime user archives (similar to database tables) can be displayed as 
tables in the picture windows of the WinCC UserArchiveControl. A 
continuous data exchange can take place with the AS via raw data tags or 
WinCC tags. 
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9.3 Communication via BSEND / BRCV 

Table 9-1 

Step Action 

1.  Generate a new connection. 

 
2.  Configure the connection parameters. 
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Step Action 

3.  Create an S7 connection between the control and WinCC. 

 
4.  Configure the S7 connection parameters. 
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9.4 Configuration in WinCC 

Table 9-2 

Step Action 

1.  Create a new tag of the data type "Raw Data Type". 

 
2.  Configure the address parameters. 

 



 
User archives

WinCC – Examples of integrated engineering with STEP 7  Entry ID: 34995306

 

Version V1.0 Issue 27.04.2009 218/230
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 C
o

p
yr

ig
h

t 
20

09
 A

ll 
rig

h
ts

 r
e

se
rv

ed
 

   

Step Action 

3.  Create a new user archive. 

4.  Check the settings. 
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9.5 Configuration in STEP 7 

Table 9-3 

Step Action 

1.  Create a data area which is to be written to the user archive of WinCC. 

 
2.  Create a data area which is to be read by the user archive of WinCC. 
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Step Action 

3.  Invoke the block "BSEND" and configure its parameters. 

 
4.  Invoke the block "BRECV" and configure its parameters. 
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9.6 Further reading 

This list is not complete and only represents a selection of relevant 
literature. 

Table 9-4 

 Topic Title 

\1\ Writing an S7 REAL 
number into a user 
archive 

http://support.automation.siemens.com/WW/view/
en/19606614 

\2\ Deleting User Archive 
completely and 
importing new data 
records 

http://support.automation.siemens.com/WW/view/
en/11925601 

\3\ Access to User 
Archive via C-scripts 

http://support.automation.siemens.com/WW/view/
en/23050617 

\4\ Sorting of entries in 
User Archives 

http://support.automation.siemens.com/WW/view/
en/9988124 

\5\ Siemens I IA/DT 
Customer Support 

http://support.automation.siemens.com 
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http://support.automation.siemens.com/WW/view/en/11925601�
http://support.automation.siemens.com/WW/view/en/23050617�
http://support.automation.siemens.com/WW/view/en/23050617�
http://support.automation.siemens.com/WW/view/en/9988124�
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10 Glossary 

Terms which are important for comprehension of this document are 
described in the following: 

AS 

The Automation System (AS) is the English term for PC and it is frequently 
used as a synonym for it in German. 

BCD 

Binary Coded Decimal (BCD) is frequently used for the control of LCD or 
LED numerical displays or for the transmission of date and time. 

BCE 

Basic Communication Ethernet (BCE) means a 3COM-Etherlink card for 
max. 8 nodes for Industrial Ethernet communication. 

BPC 

Basic Process Control (BPC) is included in the WinCC basic system as a 
standard and it provides additional tools for configuration to realize typical 
control tasks. 

CAS 

Central Archive Server (CAS) is an option of WinCC and serves for the 
central process data archiving. 

CFC 

The Continuous Function Chart (CFC) is a method for the graphical 
programming of programmable logic controls in which function blocks are 
interconnected. 

CMMS 

The term Computerized Maintenance Management System (CMMS) 
means a computer-aided maintenance management system and describes 
the systematic software support of maintenance procedures. 

CP 

The Communication Processor (CP) is used for communication tasks in the 
automation and provides connections as the Industrial Ethernet or Profibus. 

CPU 

The Central Processing Unit (CPU) is the central processing unit of the 
PLC which is capable of executing a program. 
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CSV 

The file format Comma Separated Values (CSV) describes the structure of 
a text file for storaging or for exchanging simply structured data. 

DB 

Data Blocks (DB) do not contain STEP 7 statements which is in contrast to 
code blocks. They collect user data, i.e. there are variable data in the data 
blocks with which the user program works. 

DCF77 

The time signal transmitter DCF77 is a long-wave transmitter in Mainflingen 
which supplies the exact time to most of the radio-controlled clocks in 
Western Europe. The designation is derived from D for Germany, C for 
long-wave transmitter, F because of the vicinity to Frankfurt and the 
number 77 for the carrier frequency 77.5 kHz. 

DCS 

Distributed Control System (DCS) means a control system in the process 
control which regulates the different manufacturing processes by means of 
programmable logic control units. 

DEO 

The Diagnostic Entry Operand (DEO) is used for the criteria analysis in 
diagnosable blocks for S7-PDIAG. 

DP 

Distributed peripherals (DP) is a term from automation engineering and 
designates the connection of distributed control electronics elements for a 
(large-scale) machine to a central CPU via a bus system. The term has 
become popular with the introduction of field buses such as Profibus. 

DTM 

With the DowntimeMonitor (DTM) of the Machine Data Management 
software, downtimes can be centrally acquired and analyzed in machine-
based or line-based production plants. 

EAM 

Enterprise Architecture Management (EAM) is part of the enterprise 
architecture management. 

EPC 

Engineering, Procurement and Construction (EPC) means the project 
processing and the corresponding contract layout common in the 
international building and construction industry and, especially, plant 
engineering. 
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ERP 

Enterprise Resource Planning (ERP) is a complex application software 
which supports the resource planning of an entire enterprise. ERP 
designates the task of the enterprise to utilize the resources in an 
enterprise (capital, equipment or personnel) as efficiently as possible for 
the operations of the company. 

ES 

Engineering Stations (ES) are PCs on which the PCS 7 Engineering 
Software for the configuration of a PCS 7 project has been installed. 
To load the configuration data to the target systems (OS, BATCH, Route 
Control, AS) and perform tests in the process, an Engineering Station is 
connected to the plant bus and the terminal bus. 

FB 

Function Blocks (FB) are among the blocks which you program yourself. A 
function block is a block "with a memory". It has an assigned data block as 
memory (instance data block). 

FBD 

The programming language Function Block Diagram (FBD) uses the 
graphic logic symbols known from the Boolean algebra to represent logic. 
Complex functions as, for instance, mathematical functions, can also be 
represented directly in conjunction with the logic boxes. 

FC 

Functions (FC) are among the blocks which you program yourself. A 
function is a code block "without a memory". Temporary tags of the FC are 
stored in the local data stack. These data get lost after the FC have been 
processed. 

GMT 

Greenwich Mean Time (GMT) is the mean solar time at the Prime Meridian. 
Greenwich Mean Time was recognized as the worldwide time standard 
from 1884 to 1928. Although this function was replaced by the Coordinated 
Universal Time UTC, GMT is still a commonly used term for this time zone. 

GRAPH 

The programming language S7-GRAPH (sequential control) is used to 
program sequential controls. This includes the creation of a step sequence, 
determination of the respective step contents and the switching conditions 
(transitions). S7 GRAPH also shows complex processes in a very clear 
structure and thus enables efficient programming and troubleshooting. 
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HMI 

Human Machine Interface (HMI) permits the operator to control the 
machine, monitor the plant statuses and, if required, interfere in the 
process. 

Interlock 

Interlock is a programmable condition for step locking in process 
diagnostics which has an influence on the execution of individual actions. 

LAD 

Representation in the graphic programming language Ladder Logic (LAD) 
is based on circuit diagrams. The elements of a circuit diagram such as NC 
contact and NO contact are networked. One or several networks form the 
entire statement section of a code block. 

LAN 

A Local Area Network (LAN) is a local computer network which usually 
comprises several rooms, but rarely more than one plot of land. A local 
network can be built with various technologies. Ethernet is the most 
commonly used standard today. 

MES 

Manufacturing Execution System (MES) is a process-oriented 
manufacturing management system. It excels over similar efficient systems 
for production planning, the so-called ERP (Enterprise Resource Planning), 
due to its direct interface to automation and it permits checking the 
production in realtime. This includes classic data acquisition and 
processing such as Production Data Acquisition (PDA), Machine Data 
Acquisition (MDA) and personnel data recording but also all other 
processes which have a real-time effect on the manufacturing/production 
process. 

MFI 

Multi Function Interface (MFI) is a module slot of the CPU-series 41x-3 and 
41x-4 to extend the CPU by another PROFIBUS DP-interface with the 
module IF 964-DP. 

MPI 

The Multi Point Interface (MPI) is an interface which is used for connecting 
PUs (Programming Units), OPs (operating devices/Operator Panels) and 
other SIMATIC S7 devices. 

NTP 

The Network Time Protocol (NTP) is a standard for synchronizing clocks in 
computer systems via packet-based communication networks. NTP uses 
the connectionless UDP protocol. It was specifically developed to permit a 
reliable synchronization via networks with a variable packet runtime. 



 
Glossary

WinCC – Examples of integrated engineering with STEP 7  Entry ID: 34995306

 

Version V1.0 Issue 27.04.2009 226/230
 

C
o

p
yr

ig
h

t 


 S
ie

m
e

n
s 

A
G

 C
o

p
yr

ig
h

t 
20

09
 A

ll 
rig

h
ts

 r
e

se
rv

ed
 

   

OB 

Organisation blocks (OBs) are the interface between the operating system 
and the user program. They are invoked by the operating system and they 
control the cyclic and interrupt-driven program execution, the start response 
of the automation system and the error handling. 

OCX 

OLE custom controls (OCX) is a file which provides an ActiveX control 
element under Windows. An OCX has the same basic properties as a 
Dynamic Link Library (DLL) but it has to implement the Interface OleObject. 
This ensures that it supports the Object Linking and Embedding protocol 
(OLE). 

OEM 

Original Equipment Manufacturer (OEM) means the original equipment 
manufacturer who manufactures complete components or products in his 
own factories but who does not market them himself. 

OPC (-DA) 

OLE for Process Control (OPC) is the name of a standardized software 
interface which permits the data exchange between applications of most 
different manufacturers in automation systems. 

OS 

The Operator Station (OS) is the Human Machine Interface of the process 
control system SIMATIC PCS 7. The user can monitor, operate and control 
all processes with it. Operator Stations are available with visualized and 
pre-defined user interfaces as terminals. 

PC 

A programmable controller (PC) is, according to its inner structure, a 
microcomputer with a process periphery and it consists of the arithmetic 
and logic unit, control unit and storage. 

PCM 

Process Control Monitor (PCM) is used for collecting, manipulating, 
evaluating and storing process values. The integration into WinCC 
guarantees full transparency of all machine and plant data as a basis for 
optimization of the plant productivity. 

PLC 

A programmable logic controller (PLC) is a module which is used for open-
loop or closed-loop control of a machine or plant. Such modules are usually 
electronic and resemble the modules of a computer. The encoders 
(sensors) and the final controlling elements (actuators) are connected with 
this module. 
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PN 

Profinet (PN) is the open Industrial Ethernet standard of Profibus & Profinet 
International (PI) for automation. Profinet uses TCP/IP and IT standards, it 
is capable of realtime Ethernet and permits the integration of fieldbus 
systems. 

PNIO 

Profinet-IO has been designed for Real-Time (RT) and synchronous 
communication IRT (IRT= Isochronous Real-Time) with the distributed IO. 
The designations RT and IRT merely describe the realtime properties of the 
communication within Profinet-IO. 

RLO 

The Result of a Logic Operation (RLO) designates the signal status "0" or 
"1" of the output of a binary basic operation/logic operation which is stored 
in a register in the CPU. 

RT 

The Runtime (RT), or WinCC RT, is used for monitoring and controlling 
automatic processes. With the clear graphical interface with window 
technology the user can get a fast overview over the entire plant right up to 
the detail. 

S7 

SIMATIC 7 (S7) means the entire SIMATIC 7 series which consists, for 
instance, of the SIMATIC STEP 7 basic software for the creation of PLC 
programs and of the controllers, e.g. S7-300. 

SCADA 

Supervisory Control and Data Acquisition (SCADA) means the concept of 
supervision, control and data acquisition of technical processes. 

SDB 

The System Data Blocks (SDB) are created by different applications, 
partially also by the CPU itself and they contain both the hardware which 
was configured in STEP 7 and also the parameterized networks and 
connections. 

SFB 

A System Function Block (SFB) is a function block which is integrated in 
the S7-CPU. As SFBs are part of the operating system they are not loaded 
as part of the program. SFBs are used for communication via configured 
connections or for integrated special functions. 
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SFC 

A System Function (SFC) is a preprogrammed function which is integrated 
in the S7-CPU. You can invoke the SFC from your program. As SFCs are 
part of the operating system they are not loaded as part of the program. 
Like FCs, SFCs are blocks "without memory". 

SFM 

With the function "Report System Error" (SFM) STEP 7 provides a 
convenient option to display diagnostic information in the form of 
messages. The blocks and message texts required for this are generated 
automatically by STEP 7. The user merely has to load the created blocks to 
the CPU and transfer the messages into the WinCC project. 

SQL 

Structured Query Language (SQL) is a database language for the 
definition, query and manipulation of data in relational databases. SQL is 
ANSI and ISO standardized and is supported by almost all common 
database systems. 

SSL 

The System Status List (SSL) describes the current status of the 
automation system: It provides an overview over the configuration, current 
parameterization, current statuses and processes in the CPU and the 
assigned modules. 

STL 

The programming language Statement List (STL) is a machine-based 
textual language. The individual statements correspond to the steps with 
which the CPU performs the program execution. Several statements can be 
combined to networks. 

TIA 

Totally Integrated Automation (TIA) is an automation technology strategy 
which has been designed and developed by Siemens since 1996. This 
strategy defines the interaction of extensive single components, tools (SW) 
and the related services (spare parts service etc.). 

UDT 

User-defined Data Types (UDT) are special data structures which you 
created and which you can use according to your definition in the entire S7 
user program. UDTs can serve as templates for the creation of data blocks 
with the same data structure, i.e. you create the structure only once and 
after that you create the required data blocks by simply allocating the UDT. 
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UTC 

Universal Time Coordinated (UTC) is the international time basis which is 
determined by atomic clocks. The term GMT was first replaced by the 
politically more neutral designation UT (Universal Time). Since UT is based 
on meridian crossings of stars and, thus, follows the rotational variations of 
the earth, it is unsuitable in the second range for the worldwide coordination 
of precision devices (e.g. GPS). Therefore another system was introduced 
which contains leap seconds to smooth out these variations. This newer 
coordinated system got the extended designation UTC. 

VGA 

Video Graphics Array (VGA) refers to a computer graphics standard which 
defines certain combinations of resolution and bits per pixel (colour depth) 
and the refresh rate. 
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11 History 

Table 11-1 History 

Version Date Modifications  

V1.0 27.04.2009 First issue 
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